REN ESAS Application Note

RZ/V2L, RZ/V2H
Getting Started with Flexible Software Package

Introduction

This manual describes how to use the Renesas Flexible Software Package (FSP) for writing applications for
the RZ microprocessor series.

Target Device
Rz/V2L, RZ/V2H
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1. Introduction

1.1 Overview

This application note describes how to use the Renesas Flexible Software Package (FSP) running on the
Cortex®-M33 (hereinafter referred to as CM33) and Cortex®-R8(*)(hereinafter referred to as CR8)
incorporated on RZ/V2L, and RZ/V2H.

(*: CR8 is for RZ/V2H only.)

1.2 Introduction to FSP

1.2.1 Purpose

The Renesas Flexible Software Package (FSP) is an optimized software package designed to provide easy
to use, scalable, high quality software for embedded system design. The primary goal is to provide
lightweight, efficient drivers that meet common use cases in embedded systems.

1.2.2 e? studio IDE

FSP provides a host of efficiency enhancing tools for developing projects targeting the Renesas RZ series of
MPU devices. The e? studio IDE provides a familiar development cockpit from which the key steps of project
creation, module selection and configuration, code development, code generation, and debugging are all
managed.

1.3 Limitations

1.3.1 Peripherals and pins assignment

RZ/N/2L has a multi-core configuration of Cortex-A55 (hereinafter referred to as CA55) and CM33. Also,
RZ/V2H has a multi-core configuration of CA55, CM33 and CRa8. It is possible to use each peripheral and
GPIO from each core. This package provides drivers for each peripheral for CM33 and CRS8, but each driver
can operate on the assumption that it is not used in CA55.

1.3.2 RAM Initialization

Initialization of DDR SDRAM is always carried out in CA55 bootstrap regardless of the selection of boot
CPU, meanwhile Internal SRAM is initialized in the bootstrap of boot CPU.
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2. Starting Development Introduction

2.1 e?studio setup

2.1.1 What is e? studio?

Renesas e? studio is a development tool encompassing code development, build, and debug. e? studio is
based on the open-source Eclipse IDE and the associated C/C++ Development Tooling (CDT).

When developing for RZ MPUs, e? studio hosts the Renesas Flexible Software Package (FSP). FSP
provides a wide range of time saving tools to simplify the selection, configuration, and management of
modules and threads, to easily implement complex applications.

2.1.2 e? studio Prerequisites
2.1.2.1 Obtaining an RZ MPU Kit
To develop applications with RZ/V FSP, start with each Evaluation Board Kit.

Start-up guide of RZ/V2L Evaluation Board Kit is available at RZ/V2L SMARC EVK Start-up Guide.
Also, Getting Started of RZ/V2H Evaluation Board Kit is available at RZ/V2H EVK Getting Started.

2.1.2.2 PC Requirements
The following are the minimum PC requirements to use e? studio:

e Windows 10 with Intel i5 or i7, or AMD A10-7850K or FX
e Memory: 8-GB DDR3 or DDR4 DRAM (16-GB DDR4/2400-MHz RAM is preferred)
e  Minimum 250-GB hard disk

2.1.2.3 Licensing

FSP licensing includes full source code, limited to Renesas hardware only.

2.1.3 e?studio installation for Windows PC
This chapter describes how to install the e? studio IDE on Windows PC.

2.1.3.1 Download

The latest e? studio IDE installer package can be downloaded from Renesas website for free. Please check
detailed information from: https://www.renesas.com/e2studio. Note that user has to login to the Renesas
account (in MyRenesas page) for the software download.

RO1ANG6240EJ0200 Rev.2.00 Page 5 of 62
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2.1.3.2 Installation of e2 studio IDE

1. Double-click on e? studio installer to invoke the e? studio installation wizard page. First, you need to select

Install Type. In this material, it is expected

that Custom Install is selected. Then, click [Next >] to continue.

Note: If e? studio was installed in your PC, the option to modify, remove the existing version or install
e? studio to a different location will be displayed

&4 Renesas e? studio 2024-04 Setup

Renesas e’ studio 2024-04 Setup

Install Type

Select Install Type:

Lite Install (Recommended)
1) This installs 2 studi in Lite Mode.

Please select the e* studio installation type. Click here for help selecting a type and to see what features are included.

This mode offers a simplified experience focused on simple code editing & debugging with only important features

ows you to select which features are installed

o

RENESAS

b4

Cancel

Figure 1: e? studio installation wizard

2. Welcome page

User can change the install folder by clicking [Change...].Click [Next] to continue.

Note1: If you would like to have multiple versions of e? studio, please specify new folder here.

Note2: Multi-byte characters cannot be used

for e? studio installation folder name.

A Renesas e? studio 2024-04 Setup

Renesas e’ studio 2024-04 Setup

@ Welcome

Change...

Install directory ready

Install Location:

° Prerequisite software already installed

Internet connection available

Change Proxy Settings...

Ready to install

Software to install:
* Renesas e2 studio v24.4.0.R20240328-1906
« Java Runtime v17.0.0
* IAR Plugin Manager v1.1.0.202007251457
« Renesas e2 studio Common Components (Lite) v24.4.0.R20240328-1906
+ Renesas e2 studio Common Components (Full) v24.4.0.R20240328-1906
« Renesas QF Common Components v24.4.0.R20240328-1906
+ Eclipse CDT Linker Script Editor and DSL v1.0.111.v20240311-1345
+ Just) Adoptium OpenJDK Hotspot JRE Complete v17.0.10.v20240120-1143

o X

LENESAS

~

< Back Insta Cancel

Figure 2: Installation of e? studio — Welcome page
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3. Device Families

Select Devices Families to install. Click the [Next] button to continue.

Welcome

Renesas e’ studio 2024-04 Setup

Select the device families you wish to install support for

@ Device Families

A Renesas e studio 2024-04 Setup

u| A fA
Build, Debug & Code Generation support for Renesas RA devices
) RZ
RZ ™~
Build, Debug & Code Generation support for Renesas RZ devices
O A RL78
RU78 Build, Debug & Code Generation support for Renesas RL78 devices
0 R,
Build, Debug & Code Generation support for Renesas RX devices
O hw. RH850
RH850 Debug support for Renesas RH850 devices
AW RE
Dfre -
Build & Debug support for Renesas RE devices
0 1ENE Synergy
. SAS

Build, Debug & Code Generation support for Renesas Synergy devices

—_&ldialog P&
Select All

<Back | New> | nets

[m]

Cancel

X

RENESAS

4. Extra Features

Figure 3: Installation of e? studio — Device Families

Select Extra Features (i.e., Language packs, SVN & Git support, RTOS support...) to be installed. For

non-English language users, please select Language packs at this step if needed.

Click the [Next] button to continue.

Renesas e’ studio 2024-04 Setup

Select the extra features you wish to install

@ Extra Features ] )

24 Renesas e” studio 2024-04 Setup u} X

RENESAS

Welcome - Japanese Language Support
Device Families

Chinese (Simplified) Language Support

Chinese (Traditional) Language Support

O =
— Git Integration
O -
Git SCM Support
Terminals
] = )
ANSI/vt102 compatible Terminal support for Serial, ssh and Telnet
Select All

< Back Instal Cancel

Figure 4: Installation of e? studio — Extra Features
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5. Customize Features

Select the components to install and click the [Next] button to continue. Be sure that Renesas FSP Smart
Configurator Core and Renesas FSP Smart Configurator ARM are selected.

BN Renesas e? studio 2024-04 Setup

Renesas e” studio 2024-04 Setup

Select the components

[m] X

RLENESAS

you want to install.

s [T Additinnal Tanls

Welcome
A
Device Families » (] Renesas RE Family Support (24.4.0.R20240328-1906)
Extra Features
Customise < [J Renesas Synergy Family Support (24.4.0.R20240328-1906)
Features % [ Renesas DA Family Support (24.4.0.R20240328-1906)
Renesas FSP Smart Configurator Core (9.5.0.v20240328-0843)
Renesas FSP Smart Configurator ARM (9.5.0.v20240327-1425)
i [J Renesas RISC-V MCU Support (24.4.0.R20240328-1906)
& Renesas QE Common Components (24.4.0.R20240328-1906)
[ Git integration for Eclipse (6.8.0.202311291450-n)
v

Select All Optional | | Deselect All Optional

24 4N R2N2ANAIA-10NAY

Size of install: 912.2 MB

< Back Cancel

Figure 5: Installation of e? studio — Features

6. Additional Software

Select additional software (i.e., compilers, utilities, QE...) to be installed. Be sure to select the following

item and click [Next] to continue.

GNU ARM Embedded 12.2-Rel1

¥ Renesas e” studio 2024-04 Setup

Renesas e* studio 2024-04 Setup

Select the additional software you wish to install
Welcome [] Renesas QE

[] Renesas Al
~ [] Renesas Tool

Device Families

Extra Features

o

RENESAS

x

Ichains && Utilities

[ Renesas FSP

[ Renesas E2 Self-Checking Program V1.02.00 v1.02.00 1000 8
Customise [[] Renesas E2 Lite Self-Checking Program V1.00.00 v1.00.00 1000 B8
Features [] Renesas E1, E20 Self-Checking Program V1.01.00 v1.01.00 10008
v [m] GCC Toolchains &#& Utilities
Additional iE GNU ARM Embedded 12.2-Rel1 12.2.1.arm-12-24 10008 |
Software [#] GNU ARM Embedded 10.3 2021.10 1030202110 10008
[] GNU ARM Embedded 9.3.1 202092 9.3.1.2020q2 1000 B
[[] GNU ARM Embedded 9.2.1 2019q4 9.2.1.2019q4 1000 8
[] GNU ARM Embedded 6 2017g2 6.0.0.2017q3 10008
[7] GCC ARM A-Profile (AArch64 bare-metal) 10.3 2021.07 10.3.0.2021-07 1000 8
[[] LibGen for GNU ARM Embedded 1.2023.11 88MB

320.2 MB download required

< Back Cancel

Figure 6: Installatio

n of e? studio — Additional Software

For more details on the installation of Additional Software, please see the section 2.1.4.
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7. License Agreement
Read and accept the software license agreement. Click the [Next] button. Please note that user must
accept the license agreement, otherwise installation cannot be continued.

&M Renesas e? studio 2024-04 Setup O X

Renesas e’ studio 2024-04 Setup RE N ESAS

Welcome Please read and accept the following Software Agreements

Device Families Renesas e2 studio License Terms and Conditions for RENESAS e2 studio A
Open)DK License Agreement| | o . o
ARM DS-5 Toolchain Integrat This Renesas e2 studio license agreement ("Agreement”) is between the

Customise entity on whose behalf you are entering into this Agreement ("Client”) and
IAR Plugin Manager

Extra Features

Features Renesas Electronics Corporation, a Japanese company with its registered
» office at 3-2-24, Toyosu, Koto-ku, Tokyo 135-0061, Japan (“Renesas"). YOU
Additional SHOULD READ THIS AGREEMENT CAREFULLY, AS IT CONSTITUTES A
Software BINDING CONTRACT BETWEEN CLIENT AND RENESAS.
. The Renesas IDE Software (defined below) is intended for commercial use
@ Licenses by a company or corporation only and is not designed, developed or

produced for any private use or purpose. If you are an individual, or you
intend to install the Renesas IDE Software on behalf of an individual, or
the Renesas IDE Software is expected to be used for a private purpose
directly or indirectly, you should click "No" on the installer.

Otherwise, by clicking the "l accept” button or other button or mechanism
designed to acknowledge agreement to the terms of an electronic copy of
this Agreement, or by installing, accessing, or otherwise copying or using
all or any portion of the Renesas IDE Software, you accept this Agreement
on behalf of the entity for which you are authorized to act (e.g., an
employer) and acknowledge that such entity is legally bound by this

Anraamaont and uni ranracant and warrant that unii hawea tha rinht nawer

Print all...

< Back Instal Cancel

Figure 7: Installation of e? studio — Licenses

8. Shortcuts
Select shortcut name for start menu and click [Next] button to continue.

Note: If e? studio was installed in another location, it is recommended to rename to distinguish from the
other e? studio(s).

A Renesas e? studio 2024-04 Setup [m] ®
Renesas e? studio 2024-04 Setup
LENESAS
Welcome Shortcuts to important programs and files will be created in the following locations:

Device Families

[ In start menu group: | Renesas Electronics e2 studio
Extra Features

& Restore Default
Customise
Features

Additional
Software

Licenses

@ Shortcuts

Figure 8: Installation of e? studio — Shortcuts
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9. Summary

Components list to be installed is shown. Please confirm the contents and click the [Install] button to
install the Renesas e? studio IDE.

[ Renesas e? studio 2024-04 Setup m] X
Renesas e? studio 2024-04 Setu
P RENESAS
Welcome Ready to install @
Device Families Software to install:
* Renesas e2 studio v24.4.0.R20240328-1906
Exira Features -
« Java Runtime v17.0.0
Customise « IAR Plugin Manager v1.1.0.202007251457
Features + Renesas e2 studio Common Components (Lite) v24.4.0.R20240328-1906
R « Renesas e2 studio Common Components (Full) v24.4.0.R20240328-1906
sceitional * Renesas e2 studio Common Components for ARM Devices v24.4.0.R20240328-1906
SO + Renesas e2 studio Tools v24.4,0R20240328-1906
Licenses * Renesas RZ Family Support v24.4.0.R20240328-1906
« Renesas RZ Family Support (requiring .Net Framework) v24.4.0.R20240328-1906
Shortcuts « Renesas FSP Smart Configurator Core v9.5.0v20240328-0843
Drivers + Renesas FSP Smart Configurator ARM v9.5.0.v20240327-1425
« Renesas QF Common Components v24.4.0.R20240328-1906
@ Summary + ARM DS-5 Toolchain Integration v1.0.4v20220929-0934

+ Eclipse COT Linker Script Editor and DSL v1.0.111.v20240311-1345

« GCC for Renesas RZ Build Support v24.4.0520240326-1111

« GCC for Renesas RZ Support Files v24.4.0.v20240328-1344

« Just) Adoptium Open)DK Hotspot JRE Complete v17.0.10v20240120-1143

+ Renesas Build Support Files v9.4.0v20231010-1103

* Renesas CMake Build Support Files v9.4.0.20231010-1103

* Renesas Common Project Import/Export v9.5.0+20240319-0914

+ Renesas Debug Views v9.5.0v20240313-0842

« Renesas Debua Views (Lite) v9.5.0.v20240313-0842 N

__<Back | N pstal__J[ | concel

Figure 9: Installation of e? studio — Summary

10.Installing...

The installation is performed. Depending on selected items of additional software, new dialog prompts
may appear during the installation process. Please see chapter 2.1.3.3 for more detailed information.

11.Results
Click the OK button to complete the installation.

(24 Renesas e’ studio 2024-04 Setup ] X
Renesas e’ studio 2024-04 Setup
LKENESAS
Welcome Installation of e2 studio is complete.

Device Families Please click OK to close.

Extra Features

Customise [ Launch e2 studio?
Features [] View Release Notes?
Additional View What's New?
Software

Licenses

Shortcuts

Drivers

Summary

Installing...

@ Results

Figure 10: Summary Page

RO1ANG6240EJ0200 Rev.2.00 Page 10 of 62
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2.1.3.3 Installation of Additional Software

As mentioned in the section 2.1.3.2, the additional software listed below is essential for RZ/V FSP.

GNU ARM Embedded 12.2-Rel1.

In this section, the detailed procedure for installing this tool.

¢ GNU ARM Embedded Toolchain 12.2-Rel1

If it was selected in the Additional Software pane of €? studio, you will see the installation wizard for the
GNU ARM Embedded Toolchain during the installation process.

{37 Arm GNU Toolchain 12.2.rel1 aarch64-none-elf = X

Welcome to Arm GNU Toolchain
12 2 rell aarch64-none—elf Setup

Setup will guide you through the installation of Arm GNU
Toolchain 12.2.rel1 aarch64-none-eif.

Itis recommended that you dose all other applications
before starting Setup. This will make it possible to update
relevant system files without having to reboot your
computer,

Click Next to continue.

{57 Arm GNU Toolchain 12.2.rel1 aarch64-none-elf — X

S

License Agreement

Please review the license terms before installing Arm GNU Toolchain 12.2.rel1
aarché4-none-elf.

Press Page Down to see the rest of the agreement.

anu.org/software binutils/) A

Contains code from project GNU Binutils (b '
orafs qdb/) under the following license(s).

GNU Debugger (httos://: qnu.o!

GNU GENERAL PUBLIC LICENSE
Version 3, 29 June 2007

Copyright (C) 2007 Free Software Foundation, Inc. <http://fsf orc
Everyone is permitted to copy and distribute verbatim copies
of this license document, but changing it is not allowed.

v
If you accept the terms of the agreement, dick I Agree to continue. You must accept the
| agreement to install Arm GNU Toolchain 12.2.rel1 aarch64-none-elf,

(37 Arm GNU Toolchain 12.2.rel1 aarch64-none-elf —

Choose Install Location
Choose the folder in which to install Arm GNU Toolchain 12.2.rel1 aarch64-none-elf.

&

Setup will install Arm GNU Toolchain 12.2.rel1 aarché4-none-elf in the following folder. To
install in a different folder, dick Browse and select another folder. Click Install to start the
installation.

Destination Folder

bram Fies (:86)¥Arm GNU Toolchain aarché4-none-¢lf¥ 12.2 rel 1]

Browse...

Space required: 719.3 MB
Space available: 20.7 GB

3
!

< Back Cancel

(37 Arm GNU Toolchain 12.2.rel1 aarch64-none-elf —

Completing Arm GNU Toolchain
12 2 rell aarch64-none-elf Setup

Arm GNU Toolchain 12.2.rel1 aarch64-none-elf has been
installed on your computer.

Click Finish to dlose Setup. 4

[C]show Readme

[JLaunch geevar bat

[VAdd path to environment variable:
(] Add registry information

Figure 11: Installation of GNU ARM Embedded Toolchain
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2.1.4 e?studio installation for Linux PC
This chapter describes how to install the e? studio IDE on Linux PC.

21.41 Download
The following files are required to download before installation.

SEGGER J-Link driver
Please download the driver V7.96e or later from:
https://www.segger.com/downloads/jlink/JLink Linux V796e x86 64.deb

e? studio IDE installer

Please download the e? studio IDE installer package for Linux 2024-04 of after from:
https://www.renesas.com/e2studio.

Note that user has to login to the Renesas account (in MyRenesas page) for the software download.

2.1.4.2 Installation
This section describes the procedure of each software installation.

Filename, version number and the file path is provided for example purpose only.

e SEGGER J-Link driver
1. Open a terminal window and enter below commands.
sudo dpkg -i JLink_Linux_V796e_x86_64.deb

(If the previous install fails with unmet dependencies, retry it as follows)
sudo apt-get -f install
sudo dpkg -i JLink_Linux_V796e_x86_64.deb

e e?studio IDE

1. Run the e? studio IDE Installer. (Before running the installer, check the execution permission of the
installer.)

JJle2studio_installer-2024-04_linux_host.run

2. Welcome page

User needs to select Install Type as shown below. In this material, it is expected that Custom Install is
selected. Then, click [Next >] to continue.

[l Renesas e’ studio 2024-04 Setup [@[x]

RENESAS

Renesas e? studio 2024-04 Setup

Install Type
Please select the &2 studio installation type. Click here for help selecting a type and to see what features are included.
Select Install Type:

Lite Install (Recommended)
This installs e* studio in Lite Mox

ience focused on simple code editing & debugging with only imprtant features

This
This mode offers all extended debugging functionality and other advanced features

Figure 14: Installation of e? studio — Welcome page
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3. Welcome page (Cont’d)
User can change the install folder by clicking [Change...].
Click [Next] to continue.

Note1: If you would like to have multiple versions of e? studio, please specify new folder here.
Note2: Multi-byte characters cannot be used for e? studio installation folder name.

= Renesas e studio 2024-04 Setup (=1[E3)

RENESAS

Renesas e? studio 2024-04 Setup

@ I Install directory ready

Install Location:

Prerequisite software already installed

Change Proxy Seftings...

Ready to install

° Internet connection available
Software to install:

* Renesas e2 studio v24.4.0.R20240404-0837
« Java Runtime v17.0.0
+ 1AR Plugin Manager v1.1.0.202007251457
* Renesas e2 studio Common Components (Lite) v24.4.0.R20240404-0837
* Renesas e2 studio Commen Components (Full) v24.4.0.R20240404-0837
* Renesas QE Common Components v24.4.0.R20240404-0837
. Edlpsa CDT Linker Script Editor and DSL v1.0.111.v20240311-1345
« Just] Adoptium Open]DK Hotspot JRE Complete v17.0.10.v20240120-1143
* Renesas Build Support Files v9.4.0.v20231010-1103
+ Ranesas CMake Build Support Files v9.4.0.420231010-1103
* Renesas Common Project IMport/EXport v9.5.0.v20240319-0914
* Renesas Debug Views v9.5.0.v20240402-1238

Cancel

Figure 15: Installation of e? studio — Welcome page
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4. Device Families
Select Devices Families to install. Click the [Next] button to continue.

[} Renesas e* studio 2024-04 Setup [I=0{E3}

Renesas e? studio 2024-04 Setup

solost e lpvimatamifica oy insial supsort e RENESAS

Welcome A% RA
@ Device Families RA Build, Debug & Code Generation support for Renesas RA devices
AW RZ
RZ Build, Debug & Code Generation support for Renesas RZ devices
AW RL78

RU78 g, Debug & Code Generation support for Renesas RL78 devices

@'\ RX
RX Build, Debug & Code Generation support for Renesas RX devices
TRy

RHB850 Debug support for Renesas RH850 devices

\RE

ReEe Build & Debug support for Renesas RE devices

W, Linux on Renesas RZ

RZ Build & Debug support for Linux on Renesas RZ devices
1 DA
¢dialog
A remees frmnme B0HlA & Dahiin sunnart far Ranasac DA davicas
Select All

se S

Figure 16: Installation of e studio — Device Families

5. Extra Features
Select Extra Features (i.e., Language packs, SVN & Git support, RTOS support...) to be installed. For
non-English language users, please select Language packs at this step if needed.
Click the [Next] button to continue.

] Renesas e? studio 2024-04 Setup I=1{E3]

Renesas e? studio 2024-04 Setup

Select the extra features you wish to install ] z E N ESAS

Welcome = Japanese Language Support
s
Device Families =
@ ExFra Fentiras ~ Chinese (Simplified) Language Suppaort
el
~ Chinese (Traditional) Language Support
(=]
'
- Git Integration
=
= Git SCM Support
e, Terminals
=)

ANSINE102 compatible Terminal support for Serial, ssh and Telnet

select All

i s

Figure 17: Installation of e? studio — Extra Features
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6. Customize Features
Select the components to install and click the [Next] button to continue.

] Renesas e* studio 2024-04 Setup I=1E3

RENESAS

Renesas e? studio 2024-04 Setup
welcome Select the components you want to install.
Device Families < ([ Renesas RH850 Family Support (24.4.0.R20240404-0837)

Extra Features & [J Renesas DA Family Support (24.4.0.R20240404-0837)

Customise

Feelnres Renesas FSP Smart Configurator Core (9.5.0.v20240403-1046)

Renesas FSP Smart Configurator ARM (9.5.0.v20240327-1425)

[ Renesas QE Common Components (24.4.0.R20240404-0837)

([ Git integration for Eclipse (6.8.0.202311291450-r)

< [ Additional Tools (24.&10};20240&0&0837]

& (JT™M Terminal (4.6.0)

% [JJapanese Language Support (4.5.100)

< [J Chinese (simplified) Language Support (4.5.100)
& [[J Chinese (Traditional) Language Support (4.5.100)

Select All Optional || Deselect All Optional

Size of install: 870.8 MB

< pack caneel

Figure 18: Installation of e? studio — Features

7. Additional Software

Select additional software (i.e., compilers, utilities, QE...) to be installed. Be sure to select the “GNU
ARM Embedded 12.2-Rel1” and click [Next >] to continue.

= Renesas e* studio 2024-04 Setup I=1|E3|
Renesas e? studio 2024-04 Setup

select the additional software you wish to install u zE N E SAS

Welcome Renesas QE

Device Families ~ [ Renesas Al

Extra Features (3 Renesas Al Navigator 1.00.0
RZ/V Al TLT 1.00.0

customise [ DRP-AI TVM Tool 1.00.0

Renesas Toolchains &6& Utilities

Additional ~ BlGcc Toolchains && Utilities
Software i 4 GNU ARM Embedded 12.2-Rel1 12.2.1.arm-12-24 1000 8 |
% GNU ARM Embedded 10.3 2021.10 10.3.1.20210824 1000 B
GNU ARM Embedded 9.3.1 2020q2 9.3.1.2020q2 1000 B

& e ARM A-profile (AArch64 bare-metal) 10.3 2021.07 10.3.0.2021-07 1000 B
Renesas FSP

313.3 MB download required

= Back caneel

Figure 19: Installation of e? studio — Additional Software
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8. License Agreement
Read and accept the software license agreement. Click the [Next] button. Please note that user must
accept the license agreement, otherwise installation cannot be continued.

[ Renesas e* studio 2024-04 Setup I=1]E3]
Renesas e? studio 2024-04 Setup
RENESAS
Welcome Please read and accept the following Software Agreements
Device Families Renesas e2 studio License Terms and Conditions for RENESAS e2 studio

Extra Features OpenJDK License Agreerm yp;q qanasas e2 studio license agreement (*Agreement”) is
ARM DS-5 Toolchain Inte¢ between the entity on whose behalf you are entering into this

g::ttjgl:e 1AR Plugin Manager Agreement ("Client”) and Renesas Electronics Corporation, a
Japanese company with its registered office at 3-2-24, Toyosu,

Additional Koto-ku, Tokyo 135-0061, Japan ("Renesas”). YOU SHOULD READ

Software THIS AGREEMENT CAREFULLY, AS IT CONSTITUTES A BINDING
CONTRACT BETWEEN CLIENT AND RENESAS.

@ Licenses The Renesas IDE Software (defined below) is intended for

commercial use by a company or corporation only and is not
designed, developed or produced for any private use or purpose.
If you are an individual, or you intend to install the Renesas IDE
Software on behalf of an individual, or the Renesas IDE Software
is expected to be used for a private purpose directly or indirectly,
you should click "No" on the installer.
Otherwise, by clicking the "I accept® button or other button or
mechanism d d to ack ledge agreement to the terms of
an electronic copy of this Agreement, or by installing, accessing,
or otherwise copying or using all or any portion of the Renesas
IDE Software, you accept this Agreement on behalf of the entity
for which you are authorized to act (e.g., an employer) and
acknowledge that such entity is legally bound by this Agreement
and you represent and warrant that you have the right, power anc
authority to act on behalf of and bind such entity (if any) and

L

2 1 accept the terms of the Software Agreements I print all...

< pack :an:e‘ :

Figure 20: Installation of e? studio — Licenses
9. Shortcuts
Select shortcut name for start menu and click [Next] button to continue.

Note: If €% studio was installed in another location, it is recommended to rename to distinguish from the other
e? studio(s).

] Renesas e? studio 2024-04 Setup I=1[E3
Renesas e? studio 2024-04 Setup
LRENESAS
e Shortcuts to important programs and files will be created in the following locations:

Device Families
In the application launcher

Extra Features

Customise
Features

Additional
Software

Licenses

@ Shortcuts

= fark conest

Figure 21: Installation of e? studio — Shortcuts
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10.Summary

Components list to be installed is shown. Please confirm the contents and click the [Install] button to
install the Renesas e? studio IDE.

i Renesas e* studio 2024-04 Setup [=][x]
Renesas e? studio 2024-04 Setup
RENESAS

welcome Ready to install
Device Families Software to install:
I — * Renesas e2 studio v24.4.0.R20240404-0837

wira reatures + Java Runtime v17.0.0
Custamisa * IAR Plugin Manager v1.1.0.202007251457
" « Renesas e studioc Common Components (Lite) v24.4.0.R20240404-0837

* Renesas e2 studio Common Components (Full) v24.4.0.R20240404-0837

Additional * Renesas e2 studio Common Components for ARM Devices
Software v24.4.0.R20240404-0837

* Renesas e2 studio Tools v24.4.0.R20240404-0837

Licenses + Renesas RZ Family Support v24.4.0.R20240404-0837
Shortcuts * Renesas FSP Smart(onhguramr Core v9.5.0.v20240403-1046
* Renesas FSP Smart Conﬁguratur ARM v9.5.0.v20240327-1425
@ 5un1|“ary * Renesas QE Common Components v24.4.0.R20240404-0837

* ARM DS-5 Toolchain Integration v1.0.4.v20220929-0934

« Eclipse CDT Linker Script Editor and DSL v1.0.111.v20240311-1345
* GCC for Renesas RZ Build Support v24.4.0.v20240326-1111

* GCC for Renesas RZ Support Files v24.4.0.v20240328-1344

+ Just) Adoptium Open]DK Hotspot JRE Complete v17.0.10.v20240120-1143
* Renesas Build Support Files v9.4.0.v20231010-1103

* Renesas CMake Build Support Files v9.4.0.v20231010-1103

* Renesas Common Project Import/Export v9.5.0.v20240319-0914

* Renesas Debug Views v9.5.0.v20240402-1238

* Renesas Debug Views (Lite) v9.5.0.v20240401-1026

* Renesas QE common v2.2.1.v20240311-1519

* Renesas RTOS Debug Views v9.4.0.v20231118-1122

* Renesas RZ Debug Support v24.4.0.v20240227-1032

* Renesas RZ Debug Support Files v24.4.0.v20240402-1657

* Renesas Smart Configurator for RZ v24.4.0.v20240402-0340

< pack - concel

Figure 22: Installation of e? studio — Summary

11.Installing...

The installation is performed. Depending on selected items of additional software, new dialog prompts
may appear during the installation process.

12.Results
Click the OK button to complete the installation.

o Renesas e* studio 2024-04 Setup =1[E3]

Renesas e? studio 2024-04 Setup
RENESAS

welcome Installation of @2 studio is complete.

Device Families Flease click OK to close.

Extra Features

g Launch e2 studio?
Customise
Features View Release Notes?

(% View What's New?

Additional &

Software
Useful Links:

Licenses

Shortcuts

Summary

Installing...

@ Results

Figure 23: Summary Page
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2.2 FSP setup

2.2.1 Installation of FSP using Package Installer

Package Installer RZV_FSP_Packs_v2.0.0.exe is showcased at here. This section describes the procedure
for installation. Note that it's for Windows Host PC only.

1. Quit e2 studio.

2. Invoke RZV_FSP_Packs_v2.0.0.exe.

3. Click [Next >] to start the installation.

Renesas Flexible Software Package
(FSP) Installer

This installer will install FSP packs and documentation into an
existing e2 studic installation

The documentation will be available at

<INSTALL_DIRECTORY/fsp_documentation/rzv/<VERSION

The source for FSP can be found at
https://github.com/renesas/rzv-fsp

=

Figure 24: FSP Package Installer

4. See the license term and click [I Agree] if it's acceptable.

RZV FSP y2,0.0

- QE NES/S  rlease review the license terms before instaling Renesas RZV
FSPv2.0.0

Press Page Down to see the rest of the agreement.

-opyright [2020-2023] Renesas Electronics Corporation and/or its affiiates. AllRights A
Reserved.

This software and documentation are supplied by Renesas Electronics Corporation

land/or its affiliates and may only

lbe used with products of Renesas Electronics Corp. and its affiiates (Renesas”). No

other uses are authorized.

Renesas products are sold pursuant to Renesas terms and conditions of sale.

IPurchasers are solely responsible for

the selection and use of Renesas products and Renesas assumes no liabiity. No license,
lexpress or implied, to any ; v

If you accept all terms of the agreement, dlick I Agree.

< o

Figure 25: FSP License Term
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5. Specify e2 studio installation folder (e.g., C:\Renesas\e2studio) and click [Install].

Choose Install Location

aRENES/AS  Choose the folder in which o nstal Renesas RZV FSP 2.0.0

The installation path must point to the root of the e2 studio instalation (e.g.
C:¥Renesas¥e2_studio). Please make sure e2 studio is dosed before installation.

Browse to folder where e2 studio is installed

|
Space required: 39.2MB
Space available: 168.7 GB

i

Figure 26: Browse to the folder where e2 studio is installed

6. Click [Finish] to complete the installation.

Completing Renesas RZV FSP v2.0.0
Setup

Renesas RZV FSP ¥2.0.0 has been installed on your
computer.

Click Finish to dose Setup.

| EADpen up documentabon for this release] |

Click here to visit the FSP GitHub repository

Finish

Figure 27: Completion of FSP Installation

If the box Open up documentation for this release is checked at that time, FSP documentation for the
installed version of FSP should be opened.
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2.2.2 Installation of FSP Pack using Package Zip file

No package installer is available for Linux Host PC. Thus, you need to install FSP with the zip file
RZV_FSP_Packs_v2.0.0.zip. This section describes the procedure for installation.

1. Download RZV_FSP_Packs _v2.0.0.zip from here.

Extract the zip file to e2 studio installation directory. If it's successfully extracted, rz_fsp/rzv/packs should
be placed at <e2 stduio installation directory>/Internal/projectgen.

local > share > renesas > e2.studio >[intemal > projectgen > rfsp > rzv > packs |

Amazon FreeRTOS-Kernel.10.4 6+fsp.20.0.pack
[ Arm.CMSIs5.5.8.0+renesas 0.1sp.2.0.0.pack
Linaro.OpenAMP.1.00+f5p.2.0.0.pack
[ RenesasRzv.200.pack
RenesasRZV_baremetal_blinky.20.0.pack
| RenesasRZV_baremetal_blinky_cm33b00t 200 pack
] Renesas RZV_baremetal_minimal_cm33b00t20.0 pack
Renesas RZV_baremetal_sci4_stdio 2.00.pack
[ Renesas RZV_baremetal_scifo_printf.2.0.0.pack
RenesasRZV_board_custom 2.0.0.pack
[ RenesasRZV_board_rzv2h_evk 200 pack
RenesasRZV_board_rzv2l_smarc20.0.pack
[ Renesas RV _reertos_blinky.2.0.0.pack
RenesasRZV._freertos_blinky_cm33600t20.0pack
| Renesas RZV.freertos_minimal_cm33b00120.0,pack
[ Renesas RZV_mcu_rzv2h 200.pack
Renesas RZV_mau_rzv21.2.0.0.pack
[ SEGGER JLink7.923 pack

Figure 28: FSP Packs on e2studio installation directory

w

. At the 1st invocation of e2 studio after the extraction, FSP should be automatically installed.
4. You can check if the installation is successfully done by the procedure below:
e Click Help > CMSIS Packs Management > Renesas RZ/V

‘workspace - test/configuration.xml - e* studio

Renesas Views Run Renesas Al Window Help

@ welcome Q m®
——— @ Help Contents
{5 [test] FSP Configuration X % search = B |2 outl
Summary Show Context Help ) There i
Shom actve Kegbindings.. . jectContent || outline
Cheat Sheets.
Renesas Help »
4 Toclchain Help »
# Add Renesas Toolchains Renesas RZ/G
@ Eclipse User Storage » Renesas RZN
% perform Setup Tasks.. Renesas RZ/T

Project Summary

%, Check for Updates Renesas RZV

Board: : RZ/V2H Evaluation Kit @ Install New Software...

Device: : RIADIGOSTHAIGEG
Core:: Core 6(CM33_0) & Eclipse Marketplace...
Toolchain: : GCC for Renesas AZ
Toolchain Version: : 12.2.1.am.12-24
FSP Version: : 2.0.0 & About e studie
Project Type: : Flat

g | & FE2Y

& 1AR Embedded Workbench plugin manager..

Figure 29: CMSIS Packs Management (1)

e |If FSP is successfully installed, 2.0.0 should be listed under FSP as shown below:

= CMSIS Packs Management - Renesas RZ/V =1{E3]

Packs location:

Show in System Explorer...

Available Packs B B D &
Category Version Status

v EFsp

» [ Generic

Figure 30: CMSIS Packs Management (2)
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3. Set up an SMARC EVK
3.1 Set up an RZ/V2L SMARC EVK

Below is an example of a typical system configuration.

e? studio

SEGGER J-Link 1)

(*1) J-Link 9-pin Adapter ~ RZ/V2L SMARC EVK

Figure 31: System Configuration Example — RZ/V2L SMARC EVK

3.1.1 Supported Emulator
e SEGGER J-Link

For details on SEGGER J-Link, please see J-Link Debug Probes by SEGGER — the Embedded Experts.

3.1.2 Board Setup
3.1.21 Boot MODE

To set the board to Boot mode 3(QSPI Boot(1.8V) Mode), set the SW11 as below.

SCIF Download mode(*1 QSPI Boot (1.8V) Mode
BOOT/Power Mode Select BOOT/Power Mode Select

gyEs

E{ lij']l

Saas

eMMC Boot (1.8V)Mode
BOOT/Power Mode Select

LU S

L
SW11:Mode Setting switch
DIP-Switch-4pol-SMD
y, ;3w 8 BOOT_SELO#
2 =l i BOOT_SEL1#
3 = 6 00T_SEL2#
4 e 5 BUS_MIN
(*1) SCIF boot mode is the mode used for writing such as u-boot
4 This mode that operates only with the built-in ROM and can be used for minimum board confirmation
- See section "How to check the operation of the board"
Figure 32: Boot MODE
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3.1.2.2 JTAG connection
When connecting JTAG, you must set the DIP SW1 settings as follows:

CN2 : JTAG 10pin ARM standard connector

ARM Cortex Micro
JTAG / SWD 0.05" pitch
10pin Ribbon Cable

Connect

CN1 is a connector for analog signal input. Please careful not to accidentally connect
the JTAG cable.

SW1-1 | DEBUGEN | sW1-2 | microSDieMMC selection
OFF __ JTAGdebugmode | OFF  Select eMMC on SMARC Module
ON  Normal operation OoN Select microSD slot on SMARC Module

The selection of microSD slot and eMMC on the SMARC module is exclusive

Figure 33: JTAG connection

Please note that RZ/V2L SMARC EVK has CoreSight 10 connector and therefore, the following adapter must
be needed to connect Segger J-Link.

https://www.segger.com/products/debug-probesi/j-link/accessories/adapters/9-pin-cortex-m-adapter/

3.1.2.3 Debug Serial (console output)
Debug serial uses CN14. The baud rate is 115200bps.

CN14 : USB Type-microB Connector used as SCIF3

USB Type-microB cable

CN14:USB Type-microB Connector

Figure 34: Debug Serial(console output)
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3.1.2.4 Power Supply

Here are the power supply related goods to be used in Renesas’ development. Please prepare for the
equivalent ones for your development.

e USB Type-C cable CB-CD23BK (manufactured by Aukey)
e USB PD Charger Anker PowerPort Il 65W Pod (manufactured by Anker)

I CN6 : USB Type-C Connector for Power Supply
I

To USB-PD
m- Power Charger

USB Type-C cable

Figure 35: Power Supply

Connect USB-PD Power Charger to USB Type-C Connector. Then LED1(VBUS PWR On) and LED3
(Module PWR On) lights up. Press SW9 to turn on the power. Then LED4(Carrier PWR On) lights up.

Note: When turn on the power, press and hold the power button for 1 second.
When turn off the power, press and hold the power button for 2 seconds

Figure 36: LED Status after Turning on EVK
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3.1.2.5 How to check the operation of the board

First, check the board for problems. There are two ways to do this. Please check with either.

BOOT MODE: QSPI Boot(1.8V) Mode

If u-boot is written to the serial flash, when the power is turned on, the following will be output to the
console(CN14).

¥ COM10 - Tera Term VT - [m] x

) ES) I

BOOT MODE: SCIF Download Mode
When the power is turned on, the following will be output to the console (CN14).

[ COMA46 - Tera Term VT - m] X
ES) IVHO-IW0) R AJLF(H)

1IHF) BEE
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3.2 Setup an RZ/V2H EVK
Below is an example of a typical system configuration.

e? studio

SEGGER J-Link

(*1) J-Link 9-pin Adapter R/V2H EVK -~

Figure 37: System Configuration Example — RZ/V2L SMARC EVK

3.2.1 Supported Emulator
e SEGGER J-Link

For details on SEGGER J-Link, please see J-Link Debug Probes by SEGGER — the Embedded Experts.

3.2.2 Board Setup
3.2.21 Boot MODE

Set the boot mode using the DSW1 shown in the figure below.

Figure 38: Boot MODE
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Select the boot mode with the following settings.

Switch No. Function
1 Select the cold boot CPU
OFF: CM33/ ON: CA55
2 Input the CA55 frequency at the CA55 cold boot.

[SW2:SW3] =[OFF:OFF] : 1.6GHz
=[OFF : ON] : 1.7GHz [default]

3 =[ON : OFF] : 1.1GHz
=[ON : ON] : 1.5GHz
4 Input the boot mode select signal.

[SW4 : SW5] =[OFF : OFF] : xSPI
=[OFF :ON] : SCIF

5 =[ON : OFF] : SD
=[ON : ON] : eMMC

6 OFF: SSCG OFF / ON: SSCG ON

7 OFF: Normal mode / ON: Debug mode

8 Fix OFF

3.2.2.2 JTAG connection
When connecting to JTAG, you must set the DSW1 Switch No.7 settings as ON.

ARM Cortex Micro
JTAG / SWD 0.05" pitch
10pin Ribbon Cable

connect

Figure 39: JTAG connection

Please note that RZ/V2H EVK has CoreSight 10 connector and therefore, the following adapter must be
needed to connect Segger J-Link.

https://www.segger.com/products/debug-probes/j-link/accessories/adapters/9-pin-cortex-m-adapter/
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3.2.2.3 Debug Serial (console output)
Debug serial uses CN12. The baud rate is 115200bps.

To PC

connect

USB Type-microB cable

Figure 40: Debug Serial(console output)

3.2.2.4 Power Supply

Here are the power supply related goods to be used in Renesas’ development. Please prepare for the
equivalent ones for your development.

e USB PD Charger MAGCUBE PD 100W (AOC-CO005) (manufactured by AOHI)
e USB Type-C cable included with MAGCUBE PD 100W (AOC-C005) (manufactured by AOHI)

Check that the power slide switch SW2 and SW3 are turned OFF.

Figure 41: Power Supply
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Connect USB-PD Power Charger to CN13.
Turn the SW3 ON, then LD2 and LD7 light up.
Turn the SW2 ON, then LD1, LD3 and LD4 light up.

To USB-PD
] mm- Power Charger

USB Type-C cable

Figure 42: Power Supply
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4. Tutorial: Your First RZ MPU Project - Blinky

4.1 Tutorial Blinky

The goal of this tutorial is to quickly get acquainted with the Flexible Platform by moving through the steps of
creating a simple application using e? studio and running that application on an RZ MPU board.

4.2 What Does Blinky Do?

The application used in this tutorial is Blinky, traditionally the first program run in a new embedded
development environment.

Blinky is the "Hello World" of microprocessors. If the LED blinks you know that:

e The toolchain is setup correctly and builds a working executable image for your chip.

e The debugger has installed with working drivers and is properly connected to the board.
e The board is powered up and its jumper and switch settings are probably correct.

e The microprocessor is alive, the clocks are running, and the memory is initialized.

e Timer (GTM) interrupt is intentionally fired and GPIO is properly controlled.

Note: RZ/V2H SMARC EVK has on-board LED but RZ/V2L SRMAC EVK board does not have any LED.
Thus, Blinky sample application for RZ/V2L SRMAC EVK is designed to use the Pmod module
described below alternatively:

e Pmod LED (Four High-brightness LEDs): https://reference.digilentinc.com/pmod/pmodiled/start

This module is not included on the RZ/V2L SRMAC EVK board and so, please prepare it beforehand.

Figure 43: Connection Pmod LED module (410-076)
In the case of RZ/V2H EVK, the on-board LED is placed as below.

Figure 44: On-board LED of RZ/V2H EVK
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4.3 Create a New Project for Blinky

The creation and configuration of an RZ/V C/C++ FSP Project is the first step in the creation of an
application.

The base RZ/V pack includes a pre-written Blinky example application.
Follow these steps to create an RZ MPU project:

1. In e? studio, click File > New > C/C++ Project.

&) work - & studio

File Edit Source Refactor MNavigate Search Project RenesasViews Run Window Help

New Alt+Shift+N > Renesas C/C++ Project v &
Open File... [ Makefile Project with Existing Code
=} Open Projects from File System... [c] C/C++ Project l} M

Recent Files

> 4 Project..

Figure 45: New C/C++ Project
2. Select [Renesas RZ] > [Renesas RZ/V C/C++ FSP Project] and Click Next.

Mew C/C++ Project [m] x
)

Templates for New C/C++ Project

Al Renesas RZ/G C/C+ + FSP Project ~
CMake FEn Creote on executable or static library C/C++
Make F5P proyect for Renesas RZ/G.

Renesas Debug

R R Renesas RZ/T C/C++ FSP Project

=== Creote on executable or stotic library C/Cee
FSP project for Renesas RZ/T.

Renesac RA
Renesas RZ

Renesas RZ/V C/C+ + FSP Project
P~ Create an exscutoble or static librory C/C++
F5P project for Renesas RZV.

Figure 46: Renesas RZ/V C/C++ FSP Project

3. Assign a name to this new project. Blinky is a good name to use for this tutorial.
4. Click Next. The Project Configuration window shows your selection.

B Renesas BZV C/Cs = FSP Posject o x

Fenesas RZ/V €/C+ « PSP Project —
tion

? B e

Figure 47 : e? studio Project Configuration window (part 1)
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5. Select the board support package by selecting the name of your board from the Device Selection drop-
down list. Select GNU ARM Embedded in Toolchains and version is 12.2.1.arm-12-24 and Click Next.

) Renesas RZ/V C/C++ S Project

0 ox
Renesas RZ/V C/C++ FSP Project

Device 2nd Taols Selection

Device Selection

F5P Version: 200 Board Description

Boarg: | RzvzH Bvaluation kit -]

Device: | ROMDSGOSTHAAGES

Core Core 6(CM33.0) <

language: ®C OCre Device Details
TustZone No
Pins 1368
Processor Comex-M33

Toolchains Debugger
GNU ARM Embedded J-Link ARM

Cancel

Figure 48 : e? studio Project Configuration window (part 2)

6. Select the build artifact and RTOS. Be sure that on the current version, Secure should always be
chosen at the Sub-core start state. Otherwise, the created project can’t be built successfully.

{8 Renesas RZ/V C/C+ + FSP Project

0noox
Renesas RZ/V C/C++ FSP Project

Build Artifact, RTOS Selection and Sub-Core Selection

Build Artifact Selection

@ Executable
#_Praject builds to an execinable file

) static Library
» Prject builds to a statie library file

RTOS Selection

) Exccutable Using an RZ/V Static Library
= Praject bulles Lo &n executable file
Praject uses an existing RZ/V static library project

Sub-core start state

O Non-secure

= Start sub-care in non-secure siate

(&)

< Back

Cancel

Figure 49 : e? studio Project Configuration window (part 3)
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7. Select the Blinky template for your board and click Finish.

| BB Fenesas RIN C/Ce » PSP Project

| Renesas RZ/V C/C+ - FSP Project

Prsject Ternplate Selaction

Pugject Template Seectson

o o B Reneses ALV C/C-- FSP Project

Renesas RZ/V

€4+ FSP Project

o %

® " Bare Metal - Blinky

the C runtime envirenment.
[Renesas RZV2LA 0.0.pack]

Bare metal FSP preject that inchudes BSP and wall blink LEDs #f svslable. This preject willinitisfize clocks, pins, stacks, snd

| Bare Metal - Minimal

[Renesas RIVIL.1 00 pack]

Code Generation Seffings.
Al Use Renesas Code Formutter

Bace metal FSP progect that inchudes BSP, This project will intialize clocks, pina, stacks, and the C nntime environment,

» ,} Bare Metal (CRS core1) - Blinky
X Bar e

> o Bare Metal (CR8 core1) - Minimal

Templates for RZ/V2L

ex-2 core | that incstes BSP. T prject wil

Templates for RZ/V2H

Projec
O
13 core that icade 5P 8 Wil Dk D  walbie. TS pijct Wl Ve ks, pin, ks, 813 the C untine
3 core s nchdes 9. This projctwil sl cocs, i, acks, and the € e enicnmers.
o} ,} Bare Metal (CR8 cored) - Blinky
L Bar 1B Cared at inclais BSP and will Bink LEDs = i, andt the € ime

vesect af Corten R0 core] 113 ncudes BSP and Wil ik LEDS I avallabl. T aroject wil oz clocks,3in, Sk, and the € ki

Figure 50

: e2 studio Project Configuration window (part 4)

Once the project has been created, the name of the project will show up in the Project Explorer window
of e? studio. Now click the Generate Project Content button in the top right corner of the Project
Configuration window to generate your board specific files.

% [Blinky) FSP Configuration = 0
o
—
Project Summal A
d Y Renesas
Board: RZ/\V2H Evaluation Kit
Device: ROADIG057HA4GBG
Core: Core 8(CM33_0)
Toolchain: GCC for Renesas RZ
Toolchain Version: 122 1.arm-12-24
FSP Version: 200
Project Type: Flat
Location: ]

Selected software components

Figure 51 : e? studio Project Configuration tab

e Your new project is now created, configured, and ready to build.
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4.3.1 Details about the Blinky Configuration

The Generate Project Content button creates configuration header files, copies source files from templates,
and generally configures the project based on the state of the Project Configuration screen.

For example, if you check a box next to a module in the Components tab and click the Generate Project
Content button, all the files necessary for the inclusion of that module into the project will be copied or
created. If that same check box is then unchecked those files will be deleted.

4.3.2 Configuring the Blinky Clocks

By selecting the Blinky template, the clocks are configured by e? studio for the Blinky application. The clock
configuration tab (see 0.

Configuring Clocks) shows the Blinky clock configuration. The Blinky clock configuration is stored in the BSP
clock configuration file.

4.3.3 Configuring the Blinky Pins

By selecting the Blinky template, the GPIO pins used to toggle the LED1 are configured by e? studio for the
Blinky application. The pin configuration tab shows the pin configuration for the Blinky application (see
5.2.4.Configuring Pins). The Blinky pin configuration is stored in the BSP configuration file.

4.3.4 Configuring the Parameters for Blinky Components
The Blinky project automatically selects the following HAL components in the Components tab:

e r_gtm
e r_ioport

To see the configuration parameters for any of the components, check the Properties tab in the HAL window
for the respective driver (see 5.2.8.Adding and Configuring HAL Drivers).

4.3.5 Where is main()?

The main function is located in < project >/rzv_gen/main.c. It is one of the files that are generated during the
project creation stage and only contains a call to hal_entry(). For more information on generated files, see
Adding and Configuring HAL Drivers.

4.3.6 Blinky Example Code

The blinky application is stored in the hal_entry.c file. This file is generated by e? studio when you select the
Blinky Project template and is located in the project's src/ folder.

The application performs the following steps:

Get the LED information for the selected board by bsp_leds_t structure.

Set the configuration of Timer (GTM) and the callback function that is called when interrupt is fired.
Define the output level HIGH for the GPIO pins controlling the LEDs for the selected board.

Toggle the LEDs by writing to the GPIO pin with “R_BSP_PinWrite((bsp_io_port_pin_t) pin, pin_level)” in
callback function of GTM that is called with the specified interval.

rPODND=
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4.4 Build the Blinky Project
Highlight the new project in the Project Explorer window by clicking on it and build it.

There are three ways to build a project:
1. Click on Project in the menu bar and select Build Project.

2. Click on the hammer icon.
3. Right-click on the project and select Build Project.

& work - Blinky/configuration.xml - € studio

-

File Edit MNavigate Search enesas Views Run  Windov

A ||| 8 | |4 Debug | | 3 Biinky Debug.Flat a. Project -> Build Project
R e L b. Click hammer icon

= B |{8 [Bli FSP Confi it
O | &3 [Blinky] FSP Configura ¢. Right click -> Build Project

Project Summan
Board:

Device:
Toolchain:

Figure 52 : e? studio Project Explorer window

Once the build is complete a message is displayed in the build Console window that displays the final
image file name and section sizes in that image.

[ Pin Conflicts JEREESTER
[CDT Build Console [Blinky]
"arm-none-eabi-gcc -mthumb -mcpu=cortex-m33+nodsp+notp -tdiagnostics-pa
‘arm-none-eabi-gcc -mthumb -mcpu=cortex-m33+nodsp+nofp -fdiagnestics-pa
‘arm-none-eabi-gcc -mthumb -mcpu=cortex-m33+nodsp+nofp -fdiagnestics-pa
‘arm-none-eabi-gcc -mthumb -mcpu=cortex-m33+nodsp+nofp -fdiagnestics-pa
‘arm-none-eabi-gcc -mthumb -mcpu=cortex-m33+nodsp+nofp -fdiagnostics-pa
‘arm-none-eabi-gcc -mthumb -mcpu=cortex-m33+nodsp+nofp -fdiagnostics-pa
‘arm-none-eabi-gcc -mthumb -mcpu=cortex-m33+nodsp+nofp -fdiagnostics-pa
arm-none-eabi-gcc @"Blinky.elf.in™
arm-none-gabi-cbjcopy -0 srec “"Blinky.elf" "Blinky.srec”
arm-none-eabi-size --format=berkeley "Blinky.elf"

text data bss dec hex filename

4812 2872 16784384 16791188 103694 Blinky.elf

@5:35:14 Build Finished. @ errors, @ warnings. (tock 7s5.823ms)

Figure 53 : e? studio Project Build console
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4.5 Debug the Blinky Project

4.5.1 Debug prerequisites
To debug the project on a board, you need

e The board to be connected to e? studio
e The debugger to be configured to talk to the board
e The application to be programmed to the microprocessor

Applications run from the internal ram or external ram of your microprocessor. To run or debug the
application, the application must first be programmed to ram by JTAG debugger. SMARC EVK board has an
JTAG header and requires an external JTAG debugger to the header.

4.5.2 Debug steps

To debug the Blinky application, follow these steps:
1. Configure the debugger for your project by clicking Run > Debugger Configurations ...

Run Window Help

Renesas Device Partition Manager

@ Tracex >
B Tracealyzer >
@, Run Ctrl+F11
*, Debug F11

Run History >
©@ RunAs >

Run Configurations...

Debug History >
4 Debug As >

| Debug Configurations.. |

Q. External Tools >

Figure 54 : e? studio Debug icon

or by selecting the drop-down menu next to the bug icon and selecting Debugger Configurations ...

no launch history

Debug As >
I Debug Configurations... I

Organize Favorites... |

Figure 55 : e? studio Debugger Configurations selection option

2. Select your debugger configuration in the window. If it is not visible, then it must be created by clicking the
New icon in the top left corner of the window. Once selected, the Debug Configuration window displays
the Debug configuration for your Blinky project.
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{8 Debug Configurations o
Create, manage, and run configurations ﬁ\
FeEX B Y- Name: [Blinky Debug

[type filter text ||| OB 5 oebugger| i Startup] & Source] ] Common

[T] C/C++ Application Project

[E] C/C++ Remote Application

1 EASE Script [Blinky Browse...

[£] GDB Hardware Debugging C/C++ Application:

[£] GDB OpenOCD Debugging [DebugyBinky.lf

£ GDB Simulator Debugging (RHES0)

[ Java Applet Variables... Search Project... Browse...

[5] Java Application Build (if required) before launching

& Launch Group

[T Remote Java Application Build Cenfiguration: | Use Active ~
[ Renesas GDB Hardware Debuggin

EE Blinky Debug gand O Enable auto build O Disable auto build

[£7] Renesas Simulator Debugging (R¥, RL78) (®) Use workspace settings Configure Workspace Seftings...

Revert Appl

Filter matched 13 of 15 items Sve B

Figure 56 : e? studio Debugger Configurations window with Blinky project (1)

3. Select the debug configuration for the generated project and select the Debugger tab.
4. Click Debug to begin debugging the application.
5. Extracting RZ Debug.

B Progress Information o x
0 Preparing launch delegate...

Configuring GDB
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4.5.3 Details about the Debug Process
In debug mode, e? studio executes the following tasks:

1. Downloading the application image to the microprocessor and programming the image to the internal
and/or external memory.

Setting a breakpoint at main().

Setting the stack pointer register to the stack.

Loading the program counter register with the address of the reset vector.

Displaying the startup code where the program counter points to.

ok wn

Program Counter

4% [Blinky] RA Configyfation |.e| hal_entry.c [g startup.c 23

@ * MCU starts executing here out of re
void Reset_Handler (void)
Beeaeals i

/* Initialize system using BSP. */
BBEERala SystemInit();

/* Call user application. */
Boeeaals main();

while (1)
1]

Figure 57 : e? studio Debugger memory window

4.5.4 Run the Blinky Project
While in Debug mode, click Run > Resume or click on the Play icon twice.

L U

Figure 58 : e? studio Debugger Play icon

The LED (RZ/V2L SRMAC EVK: Pmod LED, RZ/V2H SRMAC EVK: On bord LED) should now be blinking.
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5. FSP application launch with e? studio

This section describes how to create project and debug in single core environment. Please refer to the
section 6 for the multi-core project creation and debug in RZ/V2H.

5.1 Create a Project
5.1.1 What is a Project?
In €2 studio, all FSP applications are organized in RZ MPU projects. Setting up an RZ MPU project involves:

1. Create a Project
2. Configuring a Project

These steps are described in detail in the next two sections. When you have existing projects already, after
you launch e? studio and select a workspace, all projects previously saved in the selected workspace are
loaded and displayed in the Project Explorer window. Each project has an associated configuration file
named configuration.xml, which is located in the project's root directory.

(5 Project Explorer X
+ |5 Blinky [Debug]
& Binaries
it Includes
@ v
B rov_gen
3 sre
= Debug
&= rov_cfg
= seript
Blinky Debug_Flat.jlink
Blinky Debug_Flat.launch
{8} configurationaml
RSADTGO54L236B6. pincfg

Figure 59 : e? studio Project Configuration file

Double-click on the configuration.xml file to open the RZ MPU Project Editor. To edit the project
configuration, make sure that the FSP Configuration perspective is selected in the upper right-hand corner
of the e? studio window. Once selected, you can use the editor to view or modify the configuration settings
associated with this project.

= | B C/C++ { FSP Configuration

Figure 60 : e? studio FSP Configuration Perspective

Note: Whenever the RZ project configuration (that is, the configuration.xml file) is saved, a verbose RZ
Project Report file (rzv_cfg.txt) with all the project settings is generated. The format allows differences
to be easily viewed using a text comparison tool. The generated file is located in the project root

directory.
~ &5 Blinky [Debug FSP Configuration ~
& Binaries Board "RZ/V2L Evaluation Kit (SMARC)™

RIABTGO54L23GBG
part_number: ROAG7GO54L23GBG
rom_size_bytes: @
v_gen ram_size_bytes: 131072
package_style: LFBGA
package_pins: 456

& Includes

RZV2L
series: 2

RZV2L Family

RZ/V2L Common

cure stack size (bytes): @x200
Main stack size (bytes): ©@x200
Heap size (bytes): @

MCU Vee (mV): 3300

Parameter checking: Disabled
Assert Failures: Return FSP_ERR_ASSERTION
Error Log: No Error Log

PFS Protect: Enabled

C Runtime Initialization : Enabled

Figure 61 : RZ Project Report
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The RZ Project Editor has several tabs. The configuration steps and options for individual tabs are discussed

in the following sections.

Note: The tabs available in the RZ Project Editor depend on the e? studio version and the layout may vary
slightly, however the functionality should be easy to follow.

¢ [Blinky] FSP Configuration

Summary

Project Summary

Board: RZW2H Evaluation Kit
Device: ROADIGOSTHA4GEG
Core: Core 6(CM33_0)

Toolchain: GGG for Renesas RZ

Toolchain Version: 122.1.am-12-24

FSP Version: 200
Project Type: Flat
Location:

Selected software components

‘Simple appiication that binks an LED. No RTOS included
Board Support Package Common Files:

O Port

@eneral Timer

12C Master Inferface

Arm CMSIS Version 5 - Core (M)

=0

Generate Project Content

RENESAS

V200
v20.0
V200
V200
V200

Quad Serial Peripheral Interface Flash on Expanded Serial Peripheral Inferface v20.0

5.8.0+renesas 0.05p.2.0.0

Evaluation Kit RZIVZH Support Files (RZIV2H) V200
Board support package for ROAOIGOSTHA4GES v200
Board support package for RZV2H w200
Board support package for RZNV2H (RZ/VZH) - FSP Dala V200

OEO

ISummary BSP| Clocks | Pins | Interrupts | Event Links | Stacks Componenul

Figure 62 : RZ Project Editor tabs

5.1.2 Creating a New Project
For RZ MPU applications, generate a new project using the following steps:

1. Click on File > New > C/C++ Project.

&) work - & studio

File Edit Source Refactor Mavigate Search Project RenesasViews Run  Window Help

New Alt+Shift+N » Renesas C/C++ Project

Open File... @ Makefile Project with Existing Code
3 Open Projects from File System... [€] C/C++ Project I}

Recent Files > 9 Project..

v o

Figure 63 : New RZ MPU Project

2. Then click on the Renesas RZ/V C/C++ FSP Project template for the type of project you are creating.

HNew C/C++ Project [m] x
)

Templates for New C/C++ Project

F5P project for Renesas RZ/G.
Renesas Debug

Renesas RZ/T C/C++ FSP Project
=== Creote on executable or stotic library C/Cee
FSP project for Renesas RZ/T.

Renesas RZ/V C/C+ + FSP Project
P~ Create an exscutoble or static librory C/C++
F5P project for Renesas RZ/V.

HNed > Einish Cancel

Al Renesas RZ/G C/C+ + FSP Project ~
CMake o=~ Creote an executoble or static library C/C++
Make

Figure 64 : New Project Templates
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3. Select a project name and location.

B Renesas RI/V C/Ce « PSP Prsject o b
Renesas RZ/V C/C- -~ FSP Project —

me and

7 T (o e

Figure 65 : RZ MPU Project Generator (Screen 1)
4. Click Next.

5.1.2.1 Selecting a Board and Toolchain
In the Project Configuration window select the hardware and software environment:

1. Select the FSP version.

2. Select the Board for your application. You can select an existing RZ MPU Evaluation Kit or select
Custom User Board for any of the RZ MPU devices with your own BSP definition.

3. Select the Device. The Device is automatically populated based on the Board selection. Only change
the Device when using the Custom User Board (Any Device) board selection.

4. Select the Core. You can select Core 6(CM33_0), Core 4(CR8_0) or Core 5(CR8_1) if you selected
RZ/V2H for the Device.

5. To add threads, select RTOS, or No RTOS if an RTOS is not being used.

6. The Toolchain selection defaults to GNU Arm Embedded.

7. Select the Toolchain version. This should default to the installed toolchain version.

8. Select the Debugger. The J-Link Arm Debugger is preselected.

9. Click Next.

Teokhains Debugger
GHU ARM Embedded ik ARM

9212019105

? <wa o

Figure 66 : RZ MPU Project Generator (Screen 2-1)

If Core 4(CR8_0) or Core 5(CR8_1) is selected in procedure 4, you need to select the preceding project.
To select the preceding project when creating the Core 4(CR8_0) or Core 5(CR8_1) project, it is required to
prepare Core 6(CM33_0) before Core 4(CR8_0) or Core 5(CR8_1) project creation.
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8 Renesas RZ/V C/C++ FSP Project

Renesas RZ/V C/C++ FSP Project

Preceding Project or Smart Bundle Selection

® Preceding Project: Blinky

Choose this option if you have access to the project source code of the preceding processor core or security context.

(O Smart Bundle:

Preceding Project/Smart Bundle Details

FSP version 200

Toelchain GNU ARM Embedded

Toolchain version 1221am-12-24

Board RZ/V2H Evaluation Kit
Device ROADIGOSTHA4GEG
Core CM330

Zones CM3305

?

Figure 67 : RZ MPU Project Generator (Screen 2-2)

5.1.2.2 Selecting a Project Template

In the next window, select the build artifact, Sub-core start state and RTOS. Be sure that you select Secure
as Sub-core start state in the current version.

& Renesas RZ/V C/C++ FSP Project
Renesas RZ/V C/C++ FSP Project
Build Artifact, RTOS Selection and Sub-Core Selection

Build Artifact Selection RTOS Selection

@® Executable No RTOS
& Project builds to an executable file
O static Library
® Project builds to a static library file
O Executable Using an RZ/V Static Library
® Project builds to an executable file
& Project uses an existing RZ/V static library project

Sub-core start state

@ Secure
® Start sub-core in secure state

) Non-secure
® Start sub-core in non-secure state

@ <Back Finish Cancel

Figure 68 : RZ MPU Project Generator (Screen 3)
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In the next window, select a project template from the list of available templates. By default, this screen
shows the templates that are included in your current RZ/V MPU Pack. Once you have selected the

appropriate template, click Finish.
Note: If you want to develop your own application, select the basic template for your board, Bare Metal -

Minimal or FreeRTOS - Blinky.

D Benesas BZA C/C- « FSP Broject

Renesas RZ/V C/C-~ FSP Project —_—
Project Tomplate Sebection

Pusject Template Seiection

® | Bare Metal - Blinky
Bare metal FSP project that includes B3P and will Bink LEDs if availaiste. This project will initialize clocks, pins, stacks, and
the C runtime emvironment.
[Renesas.RZV2L1.00,pack]

G Bare Metal - Minimal
Base metall FSP project that includes BSP. This project will initiakos chocks, pins, stacks, and the C runtime environment.
[Renesas RZVIL100pack]

Code Generation Seftings
[ Use Remesan Code Formatter

BB Benesss BIN C/C+ F5P Project
Renesas RZ/V C/C++ FSP Project —
Freject Temgplate Selection
Progect Template Selection

® | FreeRTOS - Blinky - Dynamic Allocation
Q FesRTCS 5 pojctthat incudes 59 s it LnkLEDS1 sl IeTOS i pre-configued for dynamic memcey

atiocation. This pevject will A wing
LEDs wil be started.
[Reneses RZVIL1 Dbpack]

B | FreeRTOS - Blinky - Static Allocation
G Fre !(!"DS F5P progect that includes BSP and will bin! IrLf.DuH 4l ler Fn (ERT’JS s pre-configured for static mameory
'Jn;wmlull rtiglize the MCU uting the 5P, akzed and 2 single

or

Code Generation Settings
A Use Remenss Code Formatter

@ Renesas REN Cicen 757 Project
Rencsas RZ/V C/C++ FSP Project
Prcjct Temolate Selection
Preject Templote Slection

® ‘} Bare Metal (CM33) - Blinky
57 piojictof CoescM3€ore that nchades BSP nd will ik LEDS f avbie, T projact will 28 locks, i 4188, 300 he C i

¥2008300

O G‘ Bare mmu(ma) Minimal
A Cortex M35 o

c B5P and willBlink LEDS If availabie, This p

vies BSP. Tis

¢ Q‘ Bare Metal (CR8 core1) - Blinky
59 pojictof ContencRR conet - i peect i

pire, ctacks, and the C runtime

| Bare Metal (CR8 core1) - Minimal
Bove metal P prjct f Conex-Rlkcore that nchudes BSP. Thi pcjectwil itz clocks, ins,sacks. and the  untme environmend
Renesas R2V200p3cK

e

RZ/V2H case

Figure 69 : RZ MPU Project Generator (Screen 4)
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When the project is created, e? studio displays a summary of the current project configuration in the RZ MPU
Project Editor.

{5} [Blinky] FSP Configuration X =]

Summary Generate Project Content

Project Summary
RZV2H Evaluation Kit RENESAS
ROADIGISTHAAGEG
Core 6(CM33_0)

GCC for Renesas RZ

Selected software components

Simple application that blinks an LED. No RTOS included V200
Board Support Package Common Files. V200
VO Port v200
V200
12G Master Interface v200
Quad Serial Peripheral Interface Flash on Expanded Serial Peripheral Interface v2.0.0
Arm CMSIS Version 5 - Core (M) v5.8.0+renesas 0 fsp2.0.0
Evaluation Kit RZV2H Support Files (RZV2H) V200
support package for R9AQSGOSTHA4GEE v20.0
support package for RZV2H v20.0
Board support package for RZ/V2H (RZVZH) - FSP Data v200

QEO

Summary BSP Clocks | Pins Interrupts Event Links | Stacks Components

Figure 70 : RZ MPU Project Editor and available editor tabs

On the bottom of the RZ MPU Project Editor view, you can find the tabs for configuring multiple aspects of
your project:

o With the Summary tab, you can see all the key characteristics of the project: board, device,
toolchain, and more.

o With the BSP tab, you can change board specific parameters from the initial project selection.

o With the Clocks tab, you can configure the MPU clock settings for your project.

o With the Interrupts tab, you can add new user events/interrupts.

e With the Stacks tab, you can add and configure FSP modules. For each module selected in this
tab, the Properties window provides access to the configuration parameters, interrupt selections.

e The Components tab provides an overview of the selected modules. Although you can also add
drivers for specific FSP releases and application sample code here, this tab is normally only used
for reference.

The functions and use of each of the supported tabs is explained in detail in the next section. Please note
that RZ/V MPU Pack doesn’t support Pins and Event Links tab and so, those tabs are grayed out as shown
above.
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5.1.3 Duplication of Resources

In the case of RZ/V2H Core 4(CR8_0) or Core 5(CR8_1) project, duplicate resources are indicated as red
character in Stacks tab when using resources that are used in the linked Core 6(CM33_0) project.

The following image is an example of both Core 6(CM33_0) and Core 4(CR8_0) projects using same
resource. The duplication of r_gtm is indicated in Stacks tab. To avoid this duplication, please change the
channel resource in Properties of r_gtm.

B \2h - Project_CR8/configuration umi - € studio

File Eoit Navigate Search Project Renesas'Views Run Window Help

) Project Explorer
5 Blinky
~ 155 Project CRB
&) Includes
By
zv.gen
st
ryely
seript

& configurationxm!

% Project CR8 Debug_Flatlaunch

%) Developer Assistance

Properties

g_timer2 Timer (r_gtm)

Q-
= 0 || minky] F5P Configuration

Stacks Configuration

Threads

~ g HAL/Commen

# g ioport 10 Pont (1

@ g timer2 Time

ioport

*[Project_CRE] FSP Configuration

Q Bhc/ces
= O |[% Fop visualzation x

o x

) FsP Configuration 4 Detug

=0

The aciive editor element does not use this view

Generate Project Content

& New Stack > £ Extend Stack > i) Remove.

HAL/Common Stacks
# g_joport 0 Port o~ g.timer2 Timer (rgtm}
riopor)
0

Summary | BSP | Clocks | Pins | Interrupts | Event Links omponents

x| @ Problems @ Smart Browser &) Console

Sertings | PrOPey vaiue
~ Common
At Parameter Checiing Defautt (857)
~ Module g_timer2 Timer (r_gtm)
v General
2 P
_Chamel GTMO |
Mode Periodic
Period 8
Period Unit Hertz

Count Source

PICLK for GTMO and 1. PSCLK for GTM2 to 7

A stack element with a bar of this color indicates 'g_timer2 T

Eror: Periphera

'GTMO' is allacated within 3 preceding project or smart bundle

z imer {r_gtm)' is a Module instance.
This instance may be referenced by one other module instance only.

Figure 71 : Duplication of resource between Core 6(CM33_0) and Core 4(CR8_0) projects
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5.2 Configuring a Project

Each of the configurable elements in an FSP project can be edited using the appropriate tab in the RZ
Configuration editor window. Importantly, the initial configuration of the MPU after reset and before any user
code is executed is set by the configuration settings in the BSP tab. When you select a project template
during project creation, e? studio configures default values that are appropriate for the associated board. You
can change those default values as needed. The following sections detail the process of configuring each of
the project elements for each of the associated tabs.

5.2.1 Summary Tab

{2} [Blinky] FSP Configuration X =]

Summary Generate Project Content

Project Summary

Board: RZAV2H Evaluation Kit RENESAS
Device: ROADSGOSTHA4GBG

Core: Core 6(CHM33_0)

Toolchain: GCC for Renesas RZ

Teolchain Version: 122.1.am-12-24

FSP Version: 200

Project Type: Fiat

Location:

Selected software components

Simple application that blinks an LED. No RTOS included V200
Board Support Package Common Files. v2o0
VO Port v200
General Timer V200
12G Master Interface v200
Quad Serial Peripheral Interface Flash on Expanded Serial Peripheral Interface v2.0.0
Arm CMSIS Version 5 - Core (M) v5.8.0+renesas 0 fsp2.0.0
Evaluation Kit RZV2H Support Files (RZV2H) V200
Board support package for R9AQSGOSTHA4GEE v20.0
Board support package for RZV2H v20.0
Board support package for RZ/V2H (RZVZH) - FSP Data V200

QEO

Summary BSP Clocks | Pins Interrupts Event Links | Stacks Components

Figure 72 : Configuration Summary tab

The Summary tab, seen in the above figure, identifies all the key elements and components of a project. It
shows the target board, the device, toolchain and FSP version. Additionally, it provides a list of all the
selected software components and modules used by the project. This is a more convenient summary view
when compared to the Components tab.

5.2.2 Configuring the BSP

The BSP tab shows the currently selected board (if any) and device. The Properties view is located in the
lower left of the Project Configurations view as shown below.

Note: If the Properties view is not visible, click Window > Show View > Properties in the top menu bar.

Summary Cluclcs Pine | Interrupts | Evert Links | Stacks | Companents
[ TN * ) Problems @ Smact Browser D) Console
RZ/V2L Evaluation Kit (SMARC)
Settings  Fropetty Vlue
~ RIADTGOSALZIGEG
part_nurnber RAADTGOSLIIGEG
rom_size_bytes 0
ram_size_bytes 131072
package_style LFEGA
package_pins 456
w RZNZL Commaon
Secure stack size (bytes) G200
Main stack size (bytes) w200
Heap size (bytes) 0
MCU Veg (mV) 2300
Parameter checking Disabled
Hizsert Failures Return FSP_ERR_ASSERTION
Emor Log Mo Error Log
PFS Pratect Enatded
€ Runteme Initializatson Enabled
w REZWIL
series 2

Figure 73 : Configuration BSP tab
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The Properties view shows the configurable options available for the BSP. These can be changed as
required. The BSP is the FSP layer above the MPU hardware. e? studio checks the entry fields to flag invalid
entries. For example, only valid numeric values can be entered for the stack size.

When you click the Generate Project Content button, the BSP configuration contents are written to
rzv_cfg/fsp_cfg/bsp/bsp_cfg.h This file is created if it does not already exist.

Warning
Do not edit this file as it is overwritten whenever the Generate Project Content button is clicked.

5.2.3 Configuring Clocks

The Clocks tab presents a graphical view of the MPU's clock tree, and each HAL driver uses the settings for
dedicated numerical calculation. For example, scif uart driver calculates the communication rate from the
settings in Clocks tab. Please note that the clock configuration is carried out on the main core (CA55) in
advance when CM33 work as sub core. Thus, clocks configuration here must align with the settings on
CA55.

In the case of CM33 cold boot, BSP will configure each clock setting in start-up process according to content
of Clocks tab.

5% [Blinky] FSP Configuration X =0

Clocks Configuration Generae Project Content

0SC 24MHz el 1aoogHz  y>iDiv/2 -/ Div /2 a00MHz ATCLK 400MHz

v /4 400MHz {ovrz v I7CLK 200MHz
LDW 00MHz POCLK 100MHz

> Div /16 100MHz PICLK 100MHz

" Div /32 50MHz P2CLK 50MHz

v lovz2

s3EMHz ~ 5/ sel: MUK XSPLCLKC v —{Div /2

Div /21333330

1 PLLCLN 1.600GHz >/ Div /2 2000z

1 Div /4 400MHz P3CLK 400MHz

> Div /3 200MHz P4CLK 200MHz

5 Div /16 100MHz PSCLK 100MHz

> Div /20 80MHz NCLK 80MHz

' Div /32 50MHz PECLK 50MHz

5 PLLDTY 1.600GHz Flov e v 16CLK 800MHz

1+/Div/2  Fy>/Div /2 00z PTCLK 400MHz
Div /4 200MHz PACLK 200MHz
Div /8 100MHz PSCLK 100MHz

Summary B9 | Clocks| Pins | Interrupts| Event Links| Stacks| Components.

Figure 74 : Configuration Clocks tab

When you click the Generate Project Content button, the clock configuration contents are written to:
rzv_gen/bsp_clock_cfg.h

This file will be created if it does not already exist.

Warning
Do not edit this file as it is overwritten whenever the Generate Project Content button is clicked.
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5.2.4 Configuring Pins

The pins tab provides flexible configuration of the MPU'’s pins. As many pins can provide multiple functions,
they can be configured on a peripheral basis. For example, selecting a serial channel via the SCIF peripheral
offers multiple options for the location of the receive and transmit pins for that module and channel. The
location and function of the pins are shown in the FSP Visualization view. For more information on the
function and color coding of the pins, please check the Legend in the FSP Visualization view.

= B |[%F Fs Visualization X | =5

| =] S O »

©¢ [Blinky] FSP Configuration X

Pin Configuration Generate Project Content

Select Pin Configuration [4d Export to CSV file 5= Configure Pin Driver Warnings 4584a8is o easess Babebe
| RZVZH-EVK.pincfg| ~ Manage configurations.
Generate data: |g_bsp_pin_cfg
PinSelection = '+ — |% Pin Configuration ~J Cycle Pin Group
iT.’.:Ef ter text Name Value Link
i d Ports ~
PO
P et T
P2 < >
D2 e
< >

Pin Function | Pin Number

Summary | BSP | Clocks Interrupts | Event Links | Stacks  Components » legend

Figure 75 : Pin Configuration

The pin configurator includes built-in conflict checker. So, if the same pin is allocated to another peripheral or
I/O function, the pin will be shown as red in the FSP Visualization view and with white cross in a red square
in the Pin Selection pane and Pin Configuration pane in the main Pins tab.

In the example shown below, port P70 is already used by the IRQ_IRQO, and the attempt to connect to this
pin to the GPT results in dangling connection error. To fix this error, select another port from the pin drop-
down list or disable the IRQ_IRQO.

43¢ *[Blinky] FSP Configuration X =g

Pin Configuration Generate Project Content

Select Pin Configuration [ Export to CSV file 5] Configure Pin Driver Warnings

[RzvaH-Evk pinctg v Manage configurations
Generate data: |g_bsp_pin_cfg

Pin Selection i= [ 1=/ [% Pin Configuration ~J Cycle Pin Group

© TmereeT = Pin Group Selection Mixed
~ N Timer: Operation Mode Custom
@ cpro
s ~ Input/Output
GTIOCOA @+p70 3

GPT2
GPT3
GPT4
GPTS
GPT6
GPT7
GPTS Module name:  GPTO
GPT9 9

GTIOCOAN None
GTIOC0B None
GTIOCOBN None

< >

Pin Function| Pin Number

Summary | BSP | Clocks| @ Pins| Interrupts| Event Links| Stacks | Components|

Figure 76 : e2 studio Pin Configurator

When you click the Generate Project Content button, the pin configuration contents are written to:
rzv_gen\pin_data.c. This file will be created if it does not already exist.

Warning: Do not edit this file as it is overwritten whenever the Generate Project Content button is clicked.
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In the case of versions earlier than RZ/V FSP v2.0.0, It does not support Pins tab and If user would like to
use /O port, 1/0O Port setting should be applied to “src/pin_data.c” manually. For details on I/O Port setting
and, please refer to Setting GPIO with Flexible Software Package.

5.2.5 Configuring Interrupts from the Stacks Tab
You can use the Properties view in the Stacks tab to enable interrupts by setting the interrupt priority.
Select the driver in the Stacks pane to view and edit its properties.

¥ [Binky] FSP Configuration

Stacks Configuration : o -
Generate Project Content
HAL/Common Stacks 4| New Stack > | Remove
omeman -
10 Port Driv iopart 4 g ieport 0 Port ¥ g.Smer2 Tines rbves |
7 el Drives on 1 ioport onrgim
Objects
Summary | BSP | Clocks | Fins [ Intermupts | Event Links | Stacks| Components

[T Properties ¢ |[¥] Problems @ Smart Browser [ Console
g_timer2 Timer Driver on r_gtm
Sctlings  Propesty Value
~ Common

Paramneter Checking Default (B5F)
~ Module g_timer2 Timer Driver on 1_gtm

Genenl

Interrupts

Evtra Features

Figure 77 : Configuring Interrupts in the Stacks tab

File Edit Navigate Search Project RenesasViews Run Window Help

& | % ®m % Debug 7 Blinky Debug_flat Nl R®~{~2:'0% X e Q~- - » - | Vv - - v
Q o8| BC/Cs+ () FSP Configuration
¥ *(Blinky] FSP Configuration x Project Explorer x C
- o | v & Blinky
Stacks Configuration T e
& Includes
Threads - HAL/Common Stacks ¢ New Stack v
~ %' HAL/Common [P amsonvorer | Arm > | e ngn
& g_ioport IO Port Driver on r_ioport q:‘ﬂsor‘ V0 ot Driver 2 Connectivity s
Driver on r_joport FreeRTOS » Timers 3 @ Port Output Enable for GPT on r_poeg

Middleware > © rov o ® _Timer Driver on r_gpt
| Search o senfl s Timer Deiveroargm ]
Blinky Debug_Flatiaunch
2} configurationxml
RIADTGOS54L23GBG.pinctg
r2v_cfgtxt

Summary BSP| Clocks | Pins | Interrupts ks | Stacks| Components

Figure 78: Add new stack Timer (GTM)
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5.2.6 Creating Interrupts from the Interrupts Tab
On the Interrupts tab, the interrupt of the driver selected in the Stacks tab is registered.

User Events

{8} [Blinky] FSP Configuration 53

Interrupts Configuration

= 8
Q
Generate Project Content

4| New User Event >

Event

Allocations

Interrupt
0

Event

ID:46 GTMO INT (GTMa Interrupt)

1SR

gtm_int_isr

Summary [BSP | Clocks | Pins | Interrupts| Event Links| Stacks | Companents|

Figure 79 : Configuring interrupt in Interrupt Tab

And on the Interrupts tab, the user can add a peripheral interrupt create by user.
This can be done by adding a new event via the New User Event button.

5.2.7 Viewing Event Links

RZ/2L FSP doesn’t support Event Links tab, and it is grayed out.
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5.2.8 Adding and Configuring HAL Drivers

For applications that run outside or without the RTOS, you can add additional HAL drivers to your application
using the HAL/Common thread. To add drivers, follow these steps:

1. Click on the HAL/Common icon in the Stacks pane. The Modules pane changes to HAL/Common
Stacks.

2. Click New Stack to see a drop-down list of HAL level drivers available in the FSP.
3. Select a driver from the menu New Stack > Driver.

File Edit Navigate Search Project RenesasViews Run Window Help

|| % || ®]|®0Detug K7 Blinky Debug_Flat

& *[Blinky] FSP Configuration x

Stacks Configuration u .

Threads HAL/Common Stacks
S — Am

# g_ioport /O Port Driver on r_ioport ’ ‘i—l""’”"“”"‘"‘ Driver > Connectivity
ey FreeRTOS > | Timers

[ C/C++ (& FSP Configuration

@
RIAOTGOS4L23GBG pinclg
rzv_cfgat

Summary BSP Clocks Interrupts Eve: ks | Stacks Components

Figure 80 : e? studio Project configurator - Adding drivers

4. Select the driver module in the HAL/Common Modules pane and configure the driver properties in the
Properties view.

e? studio adds the following files when you click the Generate Project Content button:
e The selected driver module and its files to the rzv/fsp directory
e The main() function and configuration structures and header files for your application as shown in
the table below.

File Contents Overwritten by Generate
Project Content?
rzv_gen/main.c Contains main() calling generated | Yes

and user code. When called, the
BSP already has Initialized the

MPU.

rzv_gen/hal_data.c Configuration structures for HAL | Yes
Driver only modules.

rzv_gen/hal_data.h Header file for HAL driver only Yes
modules.

src/hal_entry.c User entry point for HAL Driver No

only code. Add your code here.

The configuration header files for all included modules are created or overwritten in this folder:
rzv_cfg/fsp_cfg
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5.3 Reviewing and Adding Components

The Components tab enables the individual modules required by the application to be included or excluded.
Modules common to all RZ/V MPU projects are preselected. All modules that are necessary for the modules
selected in the Stacks tab are included automatically. You can include or exclude additional modules by
ticking the box next to the required component.

[Blinky] FSP Configuration X

Components Configuration Generate P U,A‘ t Content
Al
Component Version Description Variant s
~ % BSP
v ¥ Board
custom Custom Board Support Files
¥ rzv2l_smarc Evaluation Kit RZ/V2L Support Files (RZ
v ¢ 2l
¥ device Board support package for ROA07G054.. RIADTGOS.
¥ device Board support package for RZV2L
device Board support package for ROA07G054.. RIADTGOS.
device Board support package for ROAD7G054.. RIADTGOS
device Board support package for ROAD7G054.. RIADTGOS
< fsp Board support package for RZ/V2L (RZ
v % CMSIS
v ¢ (MSISS
¥ CoreM Arm CMSIS Version 5 - Core (M
DsP Arm DSP Library Source
NN Arm NN Library Source
v % Common
v @ all
¥ fsp_common Board Support Package Common Files
v # HAL Drivers
v ?all
r_gpt General PWM Timer
7 r.gtm General Timer
¢ r_ioport 1/O Port v
Summary BSP Clocks Interrupts t Links | Stacks Components

Figure 81 : Components Tab

Clicking the Generate Project Content button copies the .c and .h files for each selected component into
the following folders:

e rzv/fspl/inc/api

e rzv/fspl/inc/instances

e rzv/fsp/src/bsp

e rzv/fsp/src/<Driver_Name>

e? studio also creates configuration files in the rzv_cfg/fsp_cfg folder with configuration options set in the
Stacks tab.
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5.4 Debugging the Project
Once your project builds without errors, you can use the Debugger to download your application to the board

and execute it.

To debug an application, follow these steps:

1. On the drop-down list next to the debug icon, select Debug Configurations.

BEr%-ic # -

T1 1F58 project Debug
Deug A3 :
Debug Configurations...

Organize Favarites..

2. In the Debug Configurations view, click on your project listed as MyProject Debug.

B Deoug Configurations x

Create, manage, and run configurations

Pame: | WiProject Deaug

[| Main %5 Debugger o Startup (] Common % - Source

[ /Cer pplizaion —
[ €/Ces Remote Applicatic
5 EASE Script [MyProject Hrowse.
EGDBHﬂdwalz Debuggini | | ¢/c+ Application:
T DB OpenOCD Debuggin
Debug M@ raject 2lf
[ GDB Simulator Debugging [ 1g/MyP raject.
Java Applet Variables.. | SearchProject..|  Erowse.,
if reuired) before launching
en: Use Active v
~ [E% Renesas GOB Hardwore D
[£'] MyProject Debug @ Usewor ettings
£ Aenesns Simulator Debug
< »
Revet Appl
Fitter motched 146 16 tems.

3. Secure and Non-secure Vector Address are configured in the Connection Settings tab of the Debugger

tab. The settings in below image are for setting the address of Secure and Non-secure Vector Offset (*)
mapped in Blinky project. Please note that these addresses vary in accordance with linker settings.
(*: In the case of RZ/V2H project, Non-secure Vector is empty since it is not used.)

8 Debug Configurations

FREX[BY-

T] C/C++ Remote Application
L7 EASE Script
[€] GDB Hardware Debugging
[€] GDB OpenOCD Debugging
[€7] GDB Simulator Debugging (I
1 Java Applet
[T Java Application
& Launch Group
. Remote Java Application

v [7] Renesas GDB Hardware Deb

[T Blinky Debug_Flat

[E7] Renesas Simulator Debuggir

< >

Filter matched 13 of 15 items

@

Create, manage, and run configurations

Name: [Blinky Debug_Flat

B Mnin_ & Startup | [ Common | &/ Source

Debug hardware: | }-Link ARM | Target Device:

GDB Settings  Connection Settings Debug Tool Settings

v JTAG Scan Chain
Multiple Devices
IRPre
DRPre

 Connection
Register initialization
Reset on connection
Reset before run
1D Code (Bytes)
Hold reset during connect
Reset before download
Prevent Releasing the Reset of the CM3 Core.

ROAO7GO44L23GBG.| | .

Mo v
Mo v
No ~
No ~

LSacure Vector Addrese

fon-secure Ves for Address

v SWV
Core clock (MHz)
v TrustZone

Set TrustZone secure/non-secure boundaries No

FFFFFFFFFFFFFFFFFFRFFFFFFFFFFFFF .
No v
No v
Yes ¥
=

8 select Symbol X
Filter: |
Symbol Address ~
® Systeminit S OxT2eff549
® Usagefault_Handler NS 0x6001084d
® UsageFault Handler S x72eff535

=

® _bsp_clock_init_veneer

© bsp._clock freq var_init
© bsp._clock_init
® bsp.init

. Q10010 |

Ox72effsbe

0x600107b1
0x60010835
0x60010849

<

© Warm Reset S

& Select Symbol X
Filter: |
Symbol Address A
® Usagefault_Handler_NS 0x6001084d
© UsageFault_ Handler S 0u72e7535
Ox72eff581

® bsp_clock freq_var init
® bsp_clock init

© bsp_init

© bsp_irg_cfg

0x00010000 |

xB00107b1
0xB0010835
60010849
xE00T0B48

Cancel

4. Connect the board to your PC via a standalone Segger J-Link debugger and click Debug.
Note: For details on using J-Link and connecting the board to the PC, see 3.1.2.2.JTAG connection.
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5.5 Modifying Toolchain Settings

There are instances where it may be necessary to make changes to the toolchain being used (for example,
to change optimization level of the compiler or add a library to the linker). Such modifications can be made
from within e? studio through the menu Project > Properties > Settings when the project is selected. The
following screenshot shows the settings dialog for the GNU Arm toolchain. This dialog will look slightly
different depending upon the toolchain being used.

B Properties for Blinky ] *
| Settings T T
Resource
Builders
w CfC+s Build Configuratior: | ebug [ Active] | | Manage Configurations..,
Build Varizbles
Environment
Logging  ToolSetings BB Toolchain  #° Build Steps Build Atifact [n} Binary Parsers € EmorParsers
Settings
Tool Chain Editor 5 Target Processor AR family comex-méd v
CfC++ General ptimization e 5
MCU ([ Wamings rehitecture Toolchain default b
Praject References ([ Debugging Instructionset | Thumb (-mthumb)
o] B} GMU ARM Cross Assembler : £
Re"‘.m O . e s ’ B i L] Thurnk interaark C-rethurnb- interssrk)
Fun/[Iebug Settings 15 Preprocessor
Task Repositery % Includes Endianness Toalchain default w
Ta;.kTag; *—: V'f"m"gi Float AEI FF instructions (hard)
Walidation (£ Miscellaneous
w ) GMU ARM Cross C Compiler FRU Type Fpud-sp-d 16 “
Unaligned access | Toolchain default -
Generic [-mepu=genens
Toalchain default
v B o Toolchain default
(2 General
B Libraries Toclchain defoult
 Miscellaneous Eroblod tosand
w B GHU ARR Cross Create Flash image
(% Genersl Small [-memadel=small)
wa MR RN DR e Tk € i
< >
:_?" Apply and Close Cancel

Figure 82 : e? studio Project toolchain settings

The scope for the settings is project scope which means that the settings are valid only for the project being
modified.

The settings for the linker which control the location of the various memory sections are contained in a script
file specific for the device being used. This script file is included in the project when it is created and is found
in the script folder (for example, /script/fsp.id).
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5.6 Importing an Existing Project into e? studio
1. Start by opening e? studio.

2. Open an existing Workspace to import the project and skip to step d. If the workspace does not exist,
proceed with the following steps:

a. Atthe end of e? studio startup, you will see the Workspace Launcher Dialog box as shown in the
following figure.

Eclipse Launcher
Select a directory as workspace

& studio uses the workspace directory to store its preferences and development artifacts.

WIS\ Users) < user_namele2studio\workspace

~ Browse...

[1Use this as the default and do not ask again
» Recent Workspaces

Figure 83 : Workspace Launcher dialog

b. Enter a new workspace name in the Workspace Launcher Dialog as shown in the following figure.
e? studio creates a new workspace with this name.

Eclipse Launcher
Select a directory as workspace

& studio uses the workspace directory to store its preferences and development artifacts,

QLTSI C\ Users < username>\e2studio\new workspace] Browse...

[ Use this as the default and do not ask again
» Recent Workspaces

Figure 84 : Workspace Launcher dialog - Select Workspace
c. Click Launch.

d. When the workspace is opened, you may see the Welcome Window. Click on the Workbench
arrow button to proceed past the Welcome Screen as seen in the following figure.

RENESAS

Welcome to e? studio )

WWorkbench

Figure 85 : Workbench arrow button

3. You are now in the workspace that you want to import the project into. Click the File menu in the menu
bar, as shown in the following figure.

Q fspWorkspace - FSPproject/confi
File Edit Navigate Search Proje €= Menu bar
4 Debug < Tool bar

|2

Figure 86 : Menu and tool bar
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4 Click Import on the File menu or “Import project” on Project Explorer, as shown in the following figure.

File Edit Mavigate Search Project RenesasViews Ru

New
Open File...
Open Projects i

Recent Files

Refres

Convert Line Delimiters To >

Prin

Export...

Properties
Switch Worksp:
Restart

Exit

AltsshiftsN > [y I Project Explorer 12 =

=55 Y
rom File System...
There are no projects in your workspace.

To add a project:

ar

Alt+Enter

ace >

m)

8

Figure 87 : File drop-down menu

5. In the Import dialog box, as shown in the following figure, choose the General option, then Existing

Projects into Workspace, to import the project into the current workspace.

& import [m] x
Select \“
Create new projects from an archive file or directory. E E

Select an import wizard:

[typet

ilter text |

-

v [= General

B C/C++

B Archive File
[ CMSIS Pack

[ Existing Projects into Workspace

[} File System

¥ GNUARM-NONE/RZ(DS-5) project conversion to GCC ARM Embedded
[T Preferences

(-} Projects from Folder or Archive

(2 Rename & Import Existing C/C++ Project into Workspace
@& Reneas Web¥{ b EO# T )L-FOUTIH

Ta# Renesas CATEKOR (CS+) FOUIIR

T Renesas CC-RX/CC-RL (CS+) FOTI

&# Renesas GitHub FreeRTOS (with IoT libraries) 70T+

Inctall

< Back Finish Cancel

Figure 88 : Project Import dialog with "Existing Projects into Workspace" option selected

6. Click Next.

7. To import the project, use either Select archive file or Select root directory.
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a. Click Select root directory file as shown in the following figure.

& import

Import Projects

(®) Select root directary: |\

Select a directory to search for existing Eclipse projects.

o

X

O Select archive file:

Projects:

Options

[ Search for nested projects

[ Copy projects into workspace

[ Close newly imported projects upon completion
[JHide projects that already exist in the workspace
Working sets

[ Add project to working sets

@ <Back

Select All

Deselect All

Refresh

New...

Cancel

Figure 89 : Import Existing Project dialog 1 - Select root directory

8. Click Browse.

9. For Select root directory, browse to the project folder that you want to import.

10.Select the file for import.
11.Click Open.

12.Select the project to import from the list of Projects, as shown in the following figure.

Import
Import Projects

Select a directory to search for existing Eclipse projects.

(@ Select root directory: | C:\works_RZV\work\Blinky
O Select archive file:
Projects:

Blinky (C:\works_RZV\work\Blinky)

VI Browse...

Select All
Deselect All

Refresh

Figure 90 : Import Existing Project dialog 2

13.Click Finish to import the project.

RO1AN6240EJ0200 Rev.2.00
May.31.24

RENESAS

Page 56 of 62




RZ/NV2L, RZIV2H Getting Started with Flexible Software Package
6. Multi-Core Debug

In the case of RZ/V2H, FSP supports multi-core (CM33 core, CR8 core0 and CR8 core1) operation.
This section describes how to debug multi-core environment by running Blinky project for each core.

6.1 Project Creation for each Core
1. Create workspace for each core.

workspace_cm33
workspace_cr8_0

workspace_cr8_1

Figure 91 : Workspace creation

2. Launch e2studio and specify workspace for CM33 core.

& & studio Launcher O X

Select a directory as workspace

e’ studio uses the workspace directory to store its preferences and development
artifacts.

‘ ‘\workspace_cm33 ~| | Browse...

[[] Use this as the default and do not ask again

» Recent Workspaces

Figure 92 : Launching e2studio for CM33 Core Workspace

3. Generate new project for CM33 core in accordance with section 4.3.
In the case of CM33 core project, ensure to select Core and Project Template Selection as below.

) Renesas RZ/V C/C++ FSP Project

B Renesas RZ/v C/C++ FSP Project a x Renesas RZ/V C/C++ FSP Project

Renesas RZ/V C/C++ FSP Project

Device and Tools Selection

Project Template Selection

Project Template Selection
Device Selection

® (-) Bare Metal (CM33) - Blinky
FSP Version: | 200 . Board Description -

Bare metal FSP project of Cortex-M33 core that includes BSP and will blink LEDs if available. This project
Board: RZ/V2H Evaluation Kit

will initialize clocks, pins, stacks, and the C runtime environment.

[Renesas.RZV.2.0.0.pack]
Device: RIADIGOSTHALGEG -
= Device Details
I Core: Core 6(CM33_0) “I TrustZone No O 3 Bare Metal (CM33) - Minimal
Language: @®C O Ce+ Pins 1368 Bare metal FSP project of Cortex-M33 core that includes BSP. This project will initialize clocks, pins, stacks,
Processor Cortex-M33 and the C runtime environment.
[Renesas.RZV.2.0.0.pack]
Toolchai Deby O . .
ooichains euager O _a." Bare Metal (CR8 core0) - Blinky hd
GNU ARM Embedded J-Link ARM -
Code Generation Settings
1321.2m-13-7 - Manage Toslchains [ Use Renesas Code Formatter
2 <m o e 2 | conce

Figure 93 : Setting of CM33 core project

4. Build the Blinky project for CM33 core.
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5. Generate new project for CR8 core0 in accordance with section 4.3.

In the case of CR8 core0 project, ensure to select Core, Preceding Project, and Project Template
Selection as below.

8 Renesas RZ/V C/C+ + FSP Project u] X 8 Renesas RZ/V C/C++ FSP Project u] X
Renesas RZ/V C/C++ FSP Project — Renesas RZ/V C/C++ FSP Project —
Device and Tools Selection Preceding Project er Smart Bundle Selection
Device Selection
iptior ® Preceding Project: [BINKEEM33 e S I g
FSP Version: |2.00 .| Board Description
i . Choose this option if you have access to the project source code of the preceding processor core or security context.
Board: RZ/V2H Evaluation Kit ~|[ = T Eman Bundie:
Device: ROADSGOSTHA4GRG Device Details
| cor= REO) ) I [sizone No Workspace. File System... Variables...
Language: @C OCe+ Pins 1368
Processor Cortex-R8
< 4 Preceding Project/Smart Bundle Details
&
Toolchains Debugger FSP version 200
Toolchain GNU ARM Embedded
AT s ‘ ML Y Toolchain version 132.1.am-13-7
Board RZ/V2H Evaluation Kit
1321.am-13-7 ~ Manage Toolchains... Device RIADIGOSTHA4GEG
v
®@ Bk ) Conce @ e B Concel
D Renesas RZ/V C/C++ FSP Project o x
Renesas RZ/V C/C++ FSP Project — |
Project Template Selection |
Project Template Selection
T TSR TR TR BT I
runtime environment. A

RenesasRZV.2.0.0.0ack]

®

Q'- Bare Metal (CR8 core0) - Blinky

Bare metal FSP project of Cortex-R8 cored that includes BSP and will blink LEDs if available. This project will initialize
clocks, pins, stacks, and the C runtime environment.

[Renesas.RZV.2.0.0.pack]

Q Q- Bare Metal (CR8 core0) - Minimal

Bare metal FSP of Cortex-R8 cored project that includes BSP. This project will initialize clocks, pins, stacks, and the C
runtime environment.

IRenesas R7V.2.0.0.nackl
Code Generation Settings

[/ Use Renesas Code Formatter

TR ==

Figure 94 : Setting of CR8 core0 project

6. Build the Blinky project for CR8 core0.
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7. Generate new project for CR8 core1 in accordance with section 4.3.

In the case of CR8 core1 project, ensure to select Core, Preceding Project, and Project Template
Selection as below.

B Renesas RZ/V C/C++ FSP Project o X Renesas RZ/V C/C++ FSP Project =} X
Renesas RZ/V C/C++ FSP Project — Renesas RZ/V C/C++ FSP Project —
Device and Tools Selection Preceding Project or Smart Bundle Selection
Device Selection
. @ Preceding Project: Blinky_cr 0 -
P Version: 2,00 .| Board Description
Chaoose this option if you have access to the project source code of the preceding processor core or security context
Board: RZ/V2H Evaluation Kit ~ | . ) Smart Bundle:
Device: RIADSGOSTHAAGEG T
| Core: iCore 5(CR8 1) “I TestZone No Workspace File System Variables.
Language: @ C OC++ pins 1368
Processor Cortex-R8
Preceding Project/Smart Bundle Details
Toolchains Debugger F5Pversion 200 ol
Toalchain GNU ARM Embedded
GNU ARM Embedded J-Link ARM
Toolchain version 1321am-13-7
8oard RZ/V2H Evaluation Kit
132121137 ~ Manage Toolchains.. Device ROAQ9GOSTHAGEG
v
@ <Back Finish Cancel 2 <Back Finish Cancel
@ Renesas RZ/V C/C++ FSP Project [m] X

Renesas RZ/V C/C++ FSP Project

Project Template Selection

Project Template Selection
W= Bare metal FSP of Cortex-RE corell project that includes BSP. This project will initialize clocks, pins, stacks, and the C
| runtime environment

Renesas RZV.200.p3ck)

" Bare Metal (CR8 core1) - Blinky

Bare metal FSP project of Corex-R8 core1 that includes BSP and will blink LEDs if available. This project will initialize
clocks, pins, stacks, and the € runtime environment.

[Renesas RZV.20.0,pack]

"| Bare Metal (CR8 core1) - Minimal

Bare metal FSP project of Cortex-R8 core1 that includes BSP. This project will initialize clocks, pins, stacks, and the C
runtime environment

Code Generation Settings
Use Renesas Code Formatter

< Back Next>

Cancel

Figure 95 : Setting of CR8 core1 project

6. Build the Blinky project for CR8 core1.
7. 3 projects are created in CM33 core workspace.
Copy all projects to CR8 core0 workspace and CR8 core1 workspace.

workspace_cm33 i

.metadata

. copy .
workspace_cr8_( <t Blinky_cm33

workspace_cr8_1 < - Blinky_cr8_0
Blinky_cr8_1

Figure 96 : Copy the project
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6.2 Debugging the Project for each Core
1. Select the Debug Configuration on e2studio of CM33 core workspace and click Debug.

@ Debug Configurations o b
Create, manage, and run configurations ﬁ\'
FomX BY - Name: [Blinkycm33 Debug_Flat |
Run | Window Help type filter text T Main % Debugger| b Starup| & Source| [ common
Renesas Device Partition Manager —
T] C/C++ Application Project:
TraceX > [€] ¢/C+ + Remote Application -
@ Tracealyzer > EASE Script |Blmky,cm}3 Browse...
Q Run CrrisF11 [€] GDB Hardware Debugging C/C++ Application
% Debug Fit €7 GDB Simulator Debugging (RF |Debumwnk¥ em33el
Run History > 8 Launch Group =
O RunAs > ‘ 7| Benesas GOB Hardware Debuc Variables.. | |Search Project.. Browse
Run Configurations. Build (if required) befare launching
Debug History > 1 Blinky_cr8_0 Debug_Flat
4 Debug As b [E7] Blinky_cr8_1 Debug_Flat Build Configuration: |Use Active ~
3 Renesas Simulator Debugging ||| (5 enapie auto build O Disable auto build
Q_External Tools e @ Use workspace settings Configure Workspace Setfings
< >
- Revert oply
Filter matched 11 of 13 items
Figure 97 : CM33 Core Debug Configuration
2. Launch new e2stuio for CR8 core0 workspace.
& < studio Launcher [m| * ‘
Select a directory as workspace
e? studio uses the workspace directory to store its preferences and development
artifacts.
\workspace_cr8 0
[] Use this as the default and do not ask again
} Recent Workspaces
Launch Cancel
Figure 98 : Launching e2studio for CR8 Core0 Workspace
3. Select the Debug Configuration on e2studio of CR8 core0 workspace and click Debug.
@ Debug Configurations [m] o
Create, manage, and run configurations . g\
Name: |Blinky_cr8_0 Debug Flat |
Run Window Help [-) Main| 3 Debugger| # Startup| ] Common | % Source
Renesas Device Partition Manager | [€] ¢/C++ Application Project:
B Tocex €] €/C = Remote Application o
o 1rata EASE Script Blinky_crB_0 Browse...
& Tracealyzer > =
= B - [£] GDB Hardware Debugging C/C++ Application:
<] GDB Simulator Debugging (RH || | [, .
%, Debug Fi1 . Launch Group Debug/Blinky_cr8_0.elf
Run History ’ 7 Renesas GDB Hardware Debug: Variables | |Search Project Browse.
O s ’ ‘ (8l cn22 Debug Flat Build (f required) before launching
Run Configurations..
Debug History > [€] Blinky_cr8_1 Debug_Flat Build Configuration; |Use Active v
##_Debug As ’ || A Renesas Simulator Debugging (|| Enapye auto build ) Disable auto build
Q. External Toals >
< > _—
Filter matched 11 of 13 tems o Lowy
|

Figure 99 : CR8 Co

re0 Debug Configuration
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4. Launch new e2stuio for CR8 core1 workspace.

& < studio Launcher O * ‘
Select a directory as workspace
e” studio uses the workspace directory to store its preferences and development
artifacts.
\worlapace_crﬂjl ~| | Browse...
[] Use this as the default and do not ask again
» Recent Workspaces

Figure 100 : Launching e2studio for CR8 Core1 Workspace

5. Select the Debug Configuration on e2studio of CR8 core1 workspace and click Debug.

Run  Window Help
Renesas Device Partition Manager
TraceX
B Tracealyzer
€, Run
%, Debug
Run History
© RunAs
Run Configurations..
Debug History
45 _Debug As
Debug Configurations.

Qu External Tools

@ Debug Configurations

EY LI

type filter text

| [E] C/C++ Application
> [E] C/C++ Remate Application
> EASE Script
CuleFi [€] GDB Haraware Debugging
11 [£7) GDB Simulator Debugging (RH
& Launch Group
~ [E7] Renesas GDB Hardware Debug
[€7 Blinky_cm33 Debug_Flat

) &7 Blinky ¢r6.0 Debug Flat
N | Blinky_cr8_1 Debug_Fla

[£7 Renesas Simulator Debugging

< >

Filter matched 11 of 13 items

@

Create, manage, and run configurations

Name: | Blinky_cr8_1 Debug_Flat
|-} Main| %5 Debugger | B Startup| [C] Common &
Project:

[Brinky_cra_1

Source

C/C++ Application:

Browse..

|Debug/linky_cr8 1.elf

Build (if required) before launching
Build Configuration: Use Active

O Enable auto build
@ Use workspace settings

Variables.. | | Search Project.

(O Disable auto build
Configure Workspace Settings.

Browse...

Close

Figure 101 : CR8 Core1 Debug Configuration

6. You can debug each core project.
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Revision History

Description
Rev. Date Page Summary
2.00 May,31 .24 1 Added RZ/V2H to the target device.
4to0 20 Updated the description and figure based on the latest
29 to 31 development environment.
41 t0 43
46
2510 28 Added description and figure for RZ/V2H EVK.
40 Updated the description of project creation.
44 Added the section of how to avoid resource duplication
description in the case of RZ/V2H project creation.
47 to 48 Added description about the Pins tab.
58 to 62 Added description about the multi-core debugging of RZ/A1H.
1.10 Jan,31.23 51010 Updated e2sutio version to install for Windows PC and
changed images of e2studio installation
16 to 20 Updated e2studio version to install for Linux PC and changed
images of e2studio installation
231t0 24 Updated pack version to install
34 to 36 Changed Chapter 4.6 to 4.9 to a sub-chapter of Chapter 4.5
(These have been changed to Chapters 4.5.1 t0 4.5.4)
35,49 Updated the method of specifying Secure Vector Address and
Non-secure Vector Address
1.00 Jan.14.22 - First Edition issued
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General Precautions in the Handling of Microprocessing Unit and Microcontroller
Unit Products

The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the
products covered by this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products.
1. Precaution against Electrostatic Discharge (ESD)
A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps
must be taken to stop the generation of static electricity as much as possible, and quickly dissipate it when it occurs. Environmental control must be
adequate. When it is dry, a humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity.
Semiconductor devices must be stored and transported in an anti-static container, static shielding bag or conductive material. All test and
measurement tools including work benches and floors must be grounded. The operator must also be grounded using a wrist strap. Semiconductor

devices must not be touched with bare hands. Similar precautions must be taken for printed circuit boards with mounted semiconductor devices.
2. Processing at power-on

The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LSI are indeterminate and the states of
register settings and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external reset
pin, the states of pins are not guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states of pins
in a product that is reset by an on-chip power-on reset function are not guaranteed from the time when power is supplied until the power reaches the

level at which resetting is specified.
3. Input of signal during power-off state

Do not input signals or an 1/0 pull-up power supply while the device is powered off. The current injection that results from input of such a signal or /0
pull-up power supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal

elements. Follow the guideline for input signal during power-off state as described in your product documentation.
4. Handling of unused pins

Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are
generally in the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of
the LSI, an associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal

become possible.
5. Clock signals

After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program
execution, wait until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator
during a reset, ensure that the reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal

produced with an external resonator or by an external oscillator while program execution is in progress, wait until the target clock signal is stable.
6. Voltage application waveform at input pin

Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between Vi
(Max.) and Vin (Min.) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the

input level is fixed, and also in the transition period when the input level passes through the area between ViL (Max.) and Vi (Min.).
7. Prohibition of access to reserved addresses

Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these

addresses as the correct operation of the LSl is not guaranteed.
8. Differences between products

Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems.
The characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in terms
of internal memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic values,
operating margins, immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a system-

evaluation test for the given product.



Notice

1.

10.

11.

12.

13.
14.

(Note1)

Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products
and application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of your
product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the use
of these circuits, software, or information.
Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights,
or other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this
document, including but not limited to, the product data, drawings, charts, programs, algorithms, and application examples.
No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics
or others.
You shall be responsible for determining what licenses are required from any third parties, and obtaining such licenses for the lawful import, export,
manufacture, sales, utilization, distribution or other disposal of any products incorporating Renesas Electronics products, if required.
You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any
and all liability for any losses or damages incurred by you or third parties arising from such alteration, modification, copying or reverse engineering.
Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for
each Renesas Electronics product depends on the product’s quality grade, as indicated below.

"Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home

electronic appliances; machine tools; personal electronic equipment; industrial robots; etc.
"High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key
financial terminal systems; safety control equipment; etc.

Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas
Electronics document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to
human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause serious property damage (space
system; undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas Electronics
disclaims any and all liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas Electronics product
that is inconsistent with any Renesas Electronics data sheet, user's manual or other Renesas Electronics document.
No semiconductor product is absolutely secure. Notwithstanding any security measures or features that may be implemented in Renesas Electronics
hardware or software products, Renesas Electronics shall have absolutely no liability arising out of any vulnerability or security breach, including but
not limited to any unauthorized access to or use of a Renesas Electronics product or a system that uses a Renesas Electronics product. RENESAS
ELECTRONICS DOES NOT WARRANT OR GUARANTEE THAT RENESAS ELECTRONICS PRODUCTS, OR ANY SYSTEMS CREATED USING
RENESAS ELECTRONICS PRODUCTS WILL BE INVULNERABLE OR FREE FROM CORRUPTION, ATTACK, VIRUSES, INTERFERENCE,
HACKING, DATA LOSS OR THEFT, OR OTHER SECURITY INTRUSION (“Vulnerability Issues”). RENESAS ELECTRONICS DISCLAIMS ANY AND
ALL RESPONSIBILITY OR LIABILITY ARISING FROM OR RELATED TO ANY VULNERABILITY ISSUES. FURTHERMORE, TO THE EXTENT
PERMITTED BY APPLICABLE LAW, RENESAS ELECTRONICS DISCLAIMS ANY AND ALL WARRANTIES, EXPRESS OR IMPLIED, WITH
RESPECT TO THIS DOCUMENT AND ANY RELATED OR ACCOMPANYING SOFTWARE OR HARDWARE, INCLUDING BUT NOT LIMITED TO
THE IMPLIED WARRANTIES OF MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE.
When using Renesas Electronics products, refer to the latest product information (data sheets, user's manuals, application notes, “General Notes for
Handling and Using Semiconductor Devices” in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by
Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation characteristics, installation, etc. Renesas
Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products outside of such
specified ranges.
Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific
characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability
product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics
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